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Des charges multipliées par dix
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uelques lecteurs se sont étonnés 
de la récente et curieuse aug-
mentation de 25 % du prix facial 
du magazine. A cette hausse 

inopinée, une seule explication. 
La Commission paritaire des publications 
et agences de presse (CPPAP) a rejeté 
notre demande de soutien financier 
comme peut le prétendre en France la 
majorité des publications distribuées au 
grand public.

D’ordinaire, la presse peut recevoir des 
aides de l’État sous forme d’allégements 
de charges si elle respecte certains cri-
tères. Ainsi, la TVA à 19,6 % passe à 2,1 % 
pour la presse  bénéficiant de ces aides 
tandis que les tarifs postaux sont réduits 
à la portion congrue. 

L’observation des revues concurrentes 
d’Opensource-Magazine, leur contenu, 
leur périodicité, leur forme, nous lais-
saient penser que nous pourrions, nous 
aussi et légitimement, bénéficier de ces 
aides. Opensource-Magazine n’est ni 
pornographique, ni dédié à la promo-
tion d’une marque ou d’un produit spé-
cifique. 

Le contenu des magazines consacrés 
aux logiciels libres, et donc Opensour-
ce-Magazine, sont sans doute aucun les 
plus généralistes qui soit dans le rayon 
informatique puisqu’ils s’adressent aux 
utilisateurs de tous les systèmes d’ex-
ploitation informatique : Mac OS X, Win-
dows et Linux. Les possesseurs de Mac 
ou de PC sont également traités. 

Se pose aujourd’hui un évident problè-
me de distorsion de concurrence. Cer-
tains magazines sont aidés, d’autres ne 
le sont pas, alors que leur contenu traite 
de la même manière, des mêmes thè-
mes, des mêmes sujets. 

Nous avons donc choisi pour Opensour-
ce-Magazine d’augmenter le tarif facial 
de 25 %, ceci afin de pouvoir faire face 
au montant de la TVA qui ne manquera 
pas d’être plus substantiel puisque dix 
fois plus élevé que prévu à l’origine.

Pour en savoir plus :
www.cppap.fr/

www.sndp.fr/bdj/presse/COMPA.htm

Q

ne nouvelle variation d’Ubuntu est disponible. Après 
Ubuntu (Gnome), Kubuntu (KDE), Edubuntu (spécial 
éducation), etc voici Ubuntu Studio orienté multi-

média. Basé sur la dernière version en date, la 7.04, Ubuntu 
Studio est livré sur un DVD de 860 Mo compatible Intel i386. 
L’installation laisse le choix entre les configurations Audio, 
Vidéo et Graphisme. Dans ce dernier cas, les logiciels The 
Gimp, Inkscape (Opensource-Magazine n° 8), Blender, Hugin 
(Opensource-Magazine n° 8) et Scribus. seront installés par 
défaut.
L’image du DVD est téléchargeable depuis le site des concep-
teurs de cette distribution alternative et spécialisée. 

http://ubuntustudio.org/

Ubuntu version création multimédia

U

ƒ UbuntuStudio est spécialisé dans la création graphique et le multimédia.
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Le logiciel éducatif GCompris évolue
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e logiciel éducatif en français, 
GCompris (cf Opensource-Ma-
gazine n°3 p.22) est disponible 

en version 8.3. Il s’adresse aux enfants 
âgés de 2 à 10 ans. Cette évolution 
apporte de nouvelles activités, des 
améliorations visuelles et sonores, et 
des corrections d’erreurs. GCompris 
regroupe plus d’une centaine d’ac-
tivités dans les domaines aussi variés 
que la découverte de l’ordinateur, les 
mathématiques, les sciences, la géo-
graphie, les jeux, la lecture, etc. 
La version 8.3 intègre un mini-traite-
ment de texte, un jeu de pesé, un 
chat local...
GCompris est disponible sur Windows, 
sur la plupart des distribution Linux et 
sous Mac OS X (via Fink). 

Installation depuis les sources :
Récupérer l’archive gcompris-X.X.tar.
gz puis : 
  tar -xvf gcompris-X.X.tar.gz 
  cd gcompris-X.X 
  sh configure

Il faut installer les packets -devel sur 
votre distribution. Il vous faudra no-
tamment SDL, SDL_Mixer, GTK, gno-
me-canvas, gnome-python, gnome-
python-canvas) 
  make 
  make install

Un manuel d’utilisation
est disponible :

http://gcompris.net/wiki/
index.php/Manuel

http://gcompris.net/-fr-

http://gcompris.net/-Download-

L

ƒGCompris passe en version 8.3
avec une kyrielle de nouveautés.

Blender 2.44, au-delà des simples correctifs

’outil de modélisation en 3D Blender vient de sortir en 
version 2.44. Cette version qui était censée n’appor-
ter que des corrections de bogues présente des évo-

lutions marquantes, notamment la compatibilité avec les 
stations équipées de puces 64 bits. Au registre des autres 
nouveautés marquantes, Blender supporte désormais la 
fonction Subsurface Scattering (SSS) qui permet de rendre 
encore plus réalistes des matières comme les liquides, la 
peau, etc. SSS nécessite de très grosses ressources pour ses 
calculs. Un nouvel outil de sculpture est livré (Flatten), deux 
nouveaux modificateurs : Cast (morphing vers les formes 
cube, cylindre ou sphère) et Smooth (lissage des mailla-
ges). 
Cette version est disponible pour Windows, Linux () et Mac 
OS X (PPC et Intel à partir de Panther). Python 2.3 est re-
quis.

www.blender.org/development/release-logs/blender-244/
www.zoo-logique.org/3D.Blender/index.php3

www.linuxgraphic.org/forums/viewforum.php?f=8

ƒ Blender est un puissant outil gratuit de modélisation en 3D.

L

Netscape n’en finit pas de revenir

L fut un temps où le roi des navigateur internet s’appelait Netscape Na-
vigator. Et puis Microsoft a fait de son Internet Explorer, un navigateur 
de destruction massive, reléguant le sympathique butineur au rang des 

jolies pièces de musée. La dernière version de Netscape était une usine à 
gaz aussi improbable que lourde à faire fonctionner. Une équipe de déve-
loppeur a décidé de refonder Netscape en se basant cette fois sur Firefox 
2.0. La version 9.0 s’appellera Netscape Navigator. C’est le seul élément 
tangible pour l’instant puisque la date de sortie est parfaitement inconnue. 
Seul un thème graphique peut être installé dans Firefox pour les nostalgi-
ques : Netsripe.

http://blog.netscape.com/

I



Actualité

Six mois après la sortie de Firefox 2.0, Mo-
zilla arrête le support de la version 1.5. 
C’est-à-dire que le développement ces-
se complètement et qu’il n’y aura plus 
de correctifs pour d’éventuelles failles 
de sécurité. Les développeurs préfèrent 
se consacrer sur les autres logiciels et 
mettre à jour le plus récent navigateur, 
ce qui permet d’avoir une version opti-
misée de Firefox avec ses toutes derniè-
res avancées techniques.
Le 24 avril était le dernier jour pour le sup-
port de Firefox 1.5, alors qu’il y a toujours 
à peu près 40% des utilisateurs à être en-
core sous cette version. Ce qui veut dire 
qu’il est grand temps de mettre son navi-
gateur à jour vers Firefox 2.

Alx.
www.firefox.com

Le logiciel avait pour nom HandBrake, 
puis il est devenu MediaFork pour fina-
lement redevenir... Handbrake. En at-
tendant, cette application open source 
de copie de DVD est de nouveau dis-
ponible dans sa version 0.8.5.b1. Elle 
comporte de nombreuses améliorations 
dont l’incorporation et la mise à jour des 
bibliothèques de MediaFork. Parmi les 
nouveautés, on retrouve le support pour 
l’Apple TV et la PS3, le son surround (AAC 
5.1 et Dolby Pro Logic II), le support pour 
Linux sous PPC et le H.264. A noter qu’il 
s’agit d’une version bêta, donc votre 
ordinateur peut avoir un comportement 
«bizarre». Pour plus de stabilité, il est pré-
férable de rester sous HandBrake 0.7.1. 

Alx.
http://handbrake.m0k.org/

Si vous possédez de vieux Mac qui traî-
nent dans un coin, donnez-leur une nou-
velle jeunesse en leur installant Linux. 
Ubuntu est une excellente distribution qui 
vient de passer dans sa version 7.04.
Elle est surnommée « Fiesty Fawn », et est 
destinée aux ordinateurs de bureau ainsi 
que les serveurs.
Alors que la version 6 d’Ubuntu était la 
dernière version officielle à supporter les 
Mac sous PPC, la communauté a conti-
nué à travailler sur « Fiesty Fawn » pour la 
proposer justement sous PPC. On ne peut 
que la remercier. 
A noter aussi que Yellow Dog Linux est 
passée dans sa version 5.0.1 pour PPC, 
disponible depuis le site Terra Soft.
D’autres sites hébergeront cette distribu-
tion d’ici à quelques semaines.

Pour l’instant, Yellow Dog Linux est en 
deux versions, l’une à 99,95 dollars, l’autre 
à 49,95 dollars. 

Alx.

Après quelques années d’existence et de 
grands services rendus, l’encyclopédie 
vivante Wikipedia quitte internet. Non, le 
site ne ferme absolument pas, mais tout 
son contenu tient désormais sur un DVD. 
Certes, il n’est pas gratuit contrairement 
au site, puisqu’il vaut 13,99 dollars, mais il 
rendra de fiers services, surtout si on n’a 
pas forcement accès à internet. Ce DVD 
est disponible pour l’instant en anglais 
et en français avec d’autres langues en 
cours de développement. 

Alx.

Jim Parkinson, développeur chez Sun 
Microsystems, a annoncé sur son blog 
que Sun allait aider au portage d’Open-
Office.org sous Mac OS X. Cette suite 
bureautique en open source est une ex-
cellente alternative à Microsoft Office. 
Malheureusement, il n’existe aucune 
version native sous OS X. Le seul moyen 
actuel de se servir d’OpenOffice.org est 
un passage obligé par X11 ou bien d’uti-
liser NeoOffice. C’est toutefois une ex-
cellente nouvelle pour tous les utilisateurs 
Mac et surtout pour Eric Bachard qui voit 
une aide non négligeable se joindre à 
ses efforts entrepris depuis longtemps sur 
le même sujet. 
Il est aussi suggéré sur le blog que Sun 
pourrait bien proposer une version de 
StarOffice pour Mac OS X.

Alx.
http://blogs.sun.com/jpblog/entry/

open_office_porting_to_mac

http://eric.bachard.free.fr/
news/2007/05/mac-os-x-port-

officially-supported-by.html

La division italienne de Toshiba songe 
très sérieusement à installer sur ses mo-
dèles portables Tecra, Satellite, Portégé 
et Qosmio, une version de Linux. Luigi 
Cattaeneo a indiqué que le fait de pro-
poser cette option permettrait à Toshiba 
de vendre ses portables dans la zone 
des 500 euros. Ceci l’aiderait à s’impo-
ser un peu plus sur le marché européen, 
mais aussi concurrencer les leaders HP et 
Acer.
Pour l’instant, cette proposition ne 
concerne que l’Europe, et aucune infor-
mation n’indique si Toshiba prévoit d’of-
frir Linux aux US. Cette nouvelle intervient 

peu après l’annonce de Dell qui va offrir 
Ubuntu 7.04 sur certains de ses ordina-
teurs.

Alx.

Le fabricant d’ordinateurs Dell et Ca-
nonical Ltd. ont annoncé un partena-
riat en proposant, vers la fin du mois de 
mai, la dernière version d’Ubuntu 7.04 sur 
certains PC («Essential» Dimension, XPS, 
Inspiron). Cela veut dire que le système 
Windows va finalement devenir une op-
tion et qu’il n’y aura plus besoin de payer 
une licence, quand on n’en veut pas. A 
propos, Michael Dell utilise déjà Ubuntu 
7.04 sur son ordinateur portable.

Alx.

www.ubuntu.com/news/
dell-to-offer-ubuntu

Ubuntu 7.04 Feisty Fawn a fait son appa-
rition et il est toujours intéressant d’enten-
dre les réactions des nouveaux venus. 
Une personne a décidé d’en parler sur 
son blog. Cependant, il a une particulari-
té... il s’agit d’un employé de Microsoft. Il 
a donc décidé de l’installer car il voulait 
essayer quelque chose de nouveau et 
Ubuntu 7.04 était pour lui une occasion 
rêvée. Petite précision, cette personne 
ne quitte pas Microsoft, et abandonne 
encore moins son Windows. Il veut juste 
découvrir ce nouveau système d’exploi-
tation. Il a même écrit qu’il considérait le 
passage sous Mac OS X, mais n’était pas 
prêt pour l’instant à investir dans du nou-
veau matériel. Ce blog, en anglais, vaut 
vraiment le détour surtout si vous envisa-
gez de passer à Ubuntu. Il fournit aussi de 
nombreuses astuces et certaines erreurs 
à ne pas commettre lors de la cohabita-
tion entre les deux systèmes.

Alx.

http://makingtheswitch.
wordpress.com/2007/04/28/

when-did-i-become-such-a-tool/

La distribution Ubuntu n’en finit pas de 
gagner du terrain. Canonical, la société 
qui promeut et édite Ubuntu, annonce 
son intention de proposer une édition 
mobile et embarquée pour le secteur de 
la téléphonie notamment. Le producteur 
de puces Intel serait de la partie. Après 
les PC Dell livrés sous Ubuntu, nous voici 
à l’aube de l’avènement de téléphones 
mobiles sous Intel-Ubuntu.

Mozilla arrête le
support de Firefox 1.5

Le retour de l’ananas

Linux et le PPC

Wikipedia à vendre

OpenOffice.org
en Aqua

Toshiba pense à Linux

Ubuntu chez Dell

Un employé de Microsoft 
découvre Ubuntu
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Ubuntu sur mobile
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Oubliez Google, Exalead est là !

ƒ Exalead est un modeste concurrent de Google dont l’un des mérites
       est d’être français.

icrosoft n’a décidément pas perdu ses mau-
vaises habitudes. La firme se dit prête à inciter 
financièrement les grands comptes à pousser 
leurs salariés à effectuer leurs recherches sur in-

ternet par le biais de Microsoft Live Search et non plus 
par Google, devenu un véritable automatisme pour la 
plupart d’entre nous. Les incitations financières seront va-
lorisées sous forme de crédits de formation ou de servi-
ces. Si Google commence à vous énerver et que Micro-
soft ne fait pas partie de vos proches relations, utilisez le 
moteur de recherche Exalead, le moteur de recherche 
français désormais aussi disponible en anglais. 

www.exalead.fr/search

M

Plus de 400 sociétés françaises 
sont spécialisées dans le logiciel li-
bre. Ce secteur d’activité pourrait 
créer 50.000 emplois en France 
d’ici à 2010. 

400

es outils open-source dédiés à la généalogie permettent de 
réaliser de gros travaux d’archivage sur les familles comme 
vous pourrez le lire dans ce numéro, grâce notamment à 

Geneaweb. Jugeant le sujet important, la rédaction d’Open-
source-Magazine vient d’ouvrir une section de son forum en ligne 
consacrée à ce thème. Chacun pourra compléter le contenu de 
cette section qui ne demande qu’à s’enrichir des connaissances 
des uns et des autres. Il va de soi que, forum oblige, les questions 
pourront aussi être posées.
Pour participer au forum, il suffit simplement de s’inscrire en ligne, 
gratuitement.

www.opensource-magazine.com
(sélectionner : Forum dans le menu)

Espace réservé aux amateurs
de généalogie

L
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uropages, l’annuaire des professionnels contient les don-
nées de plus de 700000 entreprises européennes dans 26 
langues. Consultée depuis le monde entier à raison de 122 
millions de recherches d’entreprises en 2006, Europages a 

choisi la solution MySQL pour la gestion de ses bases. Résultat, le 
coût de leur exploitation a été divisé par quatre ! La taille de la 
base a également été réduit sensiblement.

www.europages.fr/

Europages adopte
les solutions MySQL

E

près presque deux ans d’attente, la 
version 4.0 de la distribution Debian (cf 
Opensource-Magazine n°7) est sortie. 

Pour mémoire, la célèbre distribution Ubuntu 
est fondée sur Debian. C’est aussi le cas de 
Knoppix, Xandros, Mepis, etc. Cette nouvelle 
version qui bénéficie de nombreux correctifs 
apporte aussi un lot important de nouveautés 
: nouvelle version de KDE, de Gnome, de XFce, 
noyau Linux 2.6.18, support des puces AMD 
64 bits, PHP5, amélioration de l’outil Apt, etc. 
Debian est compatible avec 11 architectures 
de processeurs (Sun SPARC (sparc), HP Alpha 
(alpha), Motorola/IBM PowerPC (powerpc), 
Intel IA-32 (i386) et IA-64 (ia64), HP PA-RISC 
(hppa), MIPS (mips, mipsel), ARM (arm), IBM 
S/390 (s390) et — nouvellement ajoutée avec 
Debian GNU/Linux 4.0 — AMD64 et Intel EM64T 
(amd64)) et traduit en 58 langues !

www.debian.org

Debian, 21 mois après

A

evant la vague des solutions libres qui 
déferle sur ses solutions propriétaires, 
Microsoft réagit et attaque. Selon la 
firme de Redmond, les logiciels libres 

violeraient pas moins de 235 de ses brevets. 
Ça rappelle le bon vieux temps où Microsoft, 
alors en pleine et insolente croissance com-
me l’est aujourd’hui Google, était au centre 
d’accusations de même nature. Les propos 
ont été tenus dans une interview accordée 
au magazine Fortune par le directeur juridi-
que du groupe, Brad Smith. Selon lui, le noyau 
GNU/Linux viole 42 brevets de Microsoft ; son 
interface en viole 65 ; OpenOffice.org 45 et 
d’autres logiciels libres 83. Pour l’heure, Micro-
soft n’apporte pas de preuve. Par contre des 
pans entiers de Windows sont des emprunts au 
monde BSD/Linux.

Microsoft accuse !

D
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Thunderbird 2.0 est disponible

e logiciel de messagerie issu de 
la même lignée que Firefox (la 
fondation Mozilla) vient d’être 

officiellement livré en version 2.0. Cet-
te évolution marque un pas en avant 
significatif avec l’apport de nouvel-
les fonctions (marquage des mails 
selon leur importance, dossiers intel-
ligents, fonctions de recherche plus 
poussées, etc) tout en conservant ses 
atouts d’origine (notamment la prise 
en compte comme modules complé-
mentaires de dictionnaires orthogra-
phiques).
Thunderbird est un gestionnaire de 
mails hors pair, à la fois puissant et 
réactif, soigné et paramétrable à sou-
hait. Cerise sur le gâteau, l’addition de 
nombreux compléments (calendrier, 
contrôle du lecteur de musique, lec-
teur de fil RSS, etc) en font, de notre 
point de vue, le logiciel de messagerie 
idéal.

Les nouveautés

Etiquetage des messages - Organisez 
les messages en leur assignant des éti-
quettes telles que « De ma douce » ou 
« Projets de RTT » pour suivre et recher-
cher facilement les informations. Vous 
pouvez choisir entre les étiquettes par 
défaut, telles que Important, Person-
nel, À faire, Peut attendre et Travail, ou 
créer vos propres étiquettes personna-
lisées. Vous pouvez également ajouter 
autant d’étiquettes que vous voulez à 
un message.
 
Historique des messages - Thunder-
bird 2 permet une navigation dans 
l’historique des messages similaire à 
celle que l’on trouve pour l’historique 
des pages d’un navigateur Web. Vous 
pouvez aller d’avant en arrière dans 
vos messages et facilement naviguer 
dans leur historique de consultation.
 
Recherche - Utilisez le panneau de 
recherche en cours de frappe pour 
accélérer la recherche parmi les mes-
sages affichés. Utilisez aussi la fonc-
tionnalité de recherche rapide qui 
démarre l’affichage des résultats dès 
que vous commencez à taper les ter-
mes recherchés. Thunderbird 2 vous 
fait gagner du temps en vous permet-
tant d’enregistrer vos recherches sous 
forme de dossiers équivalents aux dos-
siers intelligents de Mail. Relancez la 
recherche enregistrée en cliquant sur 
le dossier de recherche dans le pan-
neau des dossiers.

 Accédez facilement aux services de 
messagerie en ligne - Dans Thunder-
bird 2, vous pouvez intégrer l’accès 
aux services de messagerie en ligne 
les plus connus en entrant simplement 
vos noms d’utilisateurs et mots de pas-
se.
 
Personnalisation - Personnalisez Thun-
derbird 2 avec des centaines de mo-
dules complémentaires, gratuits, qui 
modifient l’apparence, l’ergonomie 
et les fonctionnalités de Thunderbird 
pour le faire correspondre à vos goûts. 
Vous pouvez également créer vos 
propres modèles de messages pour 
gagner du temps.

www.getthunderbird.com

(disponible pour Mac, Windows, Linux)

L

ƒComme de coutume, Thunderbird accepte 
       de nouveaux modules : calendrier,
       gestion de l’agenda, etc.

ƒ L’étiquettage revient à assigner une couleur 
       au message.

ƒVous pouvez donc installer le dictionnaire 
       français simplement.

ƒA chaque lancement, Thunderbird 
       propose de devenir le compagnon fidèle 
       de votre système.

ƒAucun dictionnaire orthographique 
       n’est installé par défaut, mais le français 
       est reconnu.
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Livres

Ubuntu, la suite
Après Thunderbird 1.5 et Ubuntu 6.10, 
voici que Framabook propose un nou-
vel ouvrage libre au téléchargement. 
Il s’agit du deuxième volume « Simple 
comme Ubuntu » consacré à la fameu-
se distribution Linux. Cette suite écrite 
par Didier Roche, permet de couvrir 
bien plus que l’essentiel pour maîtriser 
ce système d’exploitation doté de tous 
les outils pour pouvoir travailler en toute 
quiétude, tant en bureautique qu’en 
communication ou graphisme.
Ces livres sont gratuits mais les dons sont 
évidemment acceptés pour soutenir 
l’initiative. Ils sont par ailleurs vendus en  
version papier contre 13 euros chez In-
LibroVeritas.

335 pages
www.framabook.org

Les maths en 4e

L’association Sesamath (cf Open-
source-Magazine n°4 p.32) a choisi de 
produire des manuels scolaires gratuits. 
Après les cahiers MathEnPoche (MEP) 
6e, le manuel Sésamath et les cahiers 
MEP 5e poursuit 
sur sa lancée 
et propose de-
puis quelques 
semaines, le 
manuel Sésa-
math 4e pour les 
collégiens des 
établissements 
français. Plus de 
70 enseignants 
ont travaillé sur 
cet ouvrage qui 
est disponible en téléchargement libre 
ou bien en version papier contre la mo-
dique somme de 11 euros. Les manuels 
Sesamath s’appuient sur les logiciels li-
bres : MathenPoche, TracenPoche et 
CasenPoche.
Le manuel de 5e a connu un vrai succès 
en prenant 10 % des parts de marché 
avec 70 000 exemplaires vendus. 

Sésamath
http://www.sesamath.net/

Les manuels
http://manuel.sesamath.net/

« Ruby en rails »
Il y en a qui choisissent de placer une 
accorte jeune dame en une pour attirer 
le chaland. Steven Holzner a choisi de 
coller ce que nous supposons être son 
portrait sur la couverture de son ouvra-
ge « Débuter avec Ruby on Rails ». Et 
ça ne fait pas du tout le même effet. 
Qu’importe le flacon, pourvu qu’on ait 

l’ivresse. Le lan-
gage Ruby a 
pour vocation 
de créer non plus 
seulement des 
pages web mais 
carrément des 
applications web 
qui pourront, par 
exemple, inte-
ragir avec des 
bases de données. Le langage PHP 
permet déjà ce genre d’exercice. Ruby 
est, selon l’auteur « l’outil le plus pra-
tique pour mettre en place des appli-
cations web concrètes ». L’auteur a le 
bon goût d’expliquer comment installer 
les outils nécessaires sur Mac, Windows 
et Linux. Il est en outre parfaitement pé-
dagogue, ce qui est un peu normal au 
regard de l’abondante littérature infor-
matique qu’on lui doit.

24,90 € 408 pages
Edité par First Interactive

www.efirst.com

Php5 et MySQL5
Le duo formé par PHP et MySQL est ce 
qui se fait de mieux pour gérer des ba-
ses de données puissantes, universelles, 
efficaces et rapides. Le logiciel libre 
de gestion de bases de données, Kexi, 
s’appuie sur la technologie MySQL pour 
gérer ses tables.
Les contributeurs ne cessent d’apporter 
des améliorations à PHP et à MySQL les-
quels sont disponibles depuis plusieurs 
semaines en versions 5 tous les deux. Le 
« guide de survie » de PHP 5 et MysQL 5 
vient de sortir aux éditions Campus Press 
- Pearson. Cet ouvrage petit format de 
480 pages couvre « l’essentiel du code 
et des commandes » utiles certes à cel-
les et ceux qui 
ont franchi le pas 
de la nouvelle 
version mais aus-
si aux utilisateurs 
des versions pré-
cédentes. Les 
bases restent en 
effet les mêmes 
d’une version 
à l’autre. Plus 
de 200 séquen-
ces de code 
et commandes 
sont proposées par les auteurs Christian 
Wenz, Zak Greant et Chris Newman. 
L’ouvrage comprend, et ce n’est pas 
un luxe, un didacticiel pour créer sa 
première base MySQL. Saluons la clarté 
du propos. 

21 €
www.pearsoneducation.fr

Le guide du Terminal
CampusPress et 
Pearson propo-
sent un « guide de 
survie » consacré 
à Linux « compa-
gnon indispensable 
pour ne jamais se 
sentir perdu dans 
un environnement 
Linux ». Généreu-
se ambition. Cet 
ouvrage est avant 
tout un guide fouillé et complet de l’uti-
lisation des commandes de terminal qui 
peuvent être utilisées pour réaliser de 
nombreuses opérations.
Une centaine de commandes sont ainsi 
commentées avec soin par Scott Gran-
neman, auteur d’articles dans la presse 
spécialisée.
La Table des matières détaillant les su-
jets et l’index sont du plus grand secours 
à l’utilisateur débutant ou confirmé sur 
Linux, quelle que soit la distribution choi-
sie. La connaissance du terminal n’est 
évidemment pas un luxe.

15 € 410 pages
www.pearsoneducation.fr

Pour les nuls savants
La collection « Pour les nuls » éditée 
par First Interactive ne cesse de grossir. 
« HTML 4 et JavaScript » complète la 
liste depuis peu.
Destiné aux débutants et surtout aux 
initiés, cet ouvrage donne les bases 
pour créer des pages web en code 
Html à partir d’outils aussi basiques que 
le Bloc-Notes sous Windows (ou TextEdit 
sous Mac OS X ou Gedit et BlueFish sous 
Linux). Le lecteur apprendra à maîtriser 
les feuilles de styles (css), la conception 
de formulaires et les scripts, abordera 
JavaScript et les cookies et saura in fine, 
créer des images réactives à l’appro-
che du pointeur de la souris.
C’est en tout cas l’ambition que se 
donnent les auteurs. Un minimum de 
connaissance est requis en ce qui 
concerne le transfert des pages sur un 
serveur FTP, ce sujet essentiel, primor-
dial, étant, sauf erreur, passé sous si-
lence dans l’ouvrage. Impardonnable ! 
Sans la maîtrise de la publication, pas 
de site web.

590 pages 16,90 €
www.efirst.com
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Courriers

 J’ai lu avec beaucoup d’intérêt votre article sur la lutte « anti-
spams » (p.41 n°7) avec gMail.
   Ayant aussi un compte chez Yahoo, je suis en train de tester 
une solution similaire, mais en utilisant l’option « adresse secon-
daire » ou « alias » de Yahoo.
   Dans mon compte principal sur Alice, « b.ruette@libertysurf.fr » 
(celui qui est très pollué !) je le redirige vers l’adresse secondaire 
que j’ai créée dans « yahoo » et je récupère mes messages dans 
mon compte principal de « yahoo ». Dans mon cas je peux dif-
fuser mon adresse secondaire, que je peux supprimer/changer 
à tout moment. Je ne diffuse pas mon adresse principale sur 
« yahoo ». Si cela marche, et ça fonctionne déjà, je n’aurai pas 
à ouvrir un compte supplémentaire chez Google. 
  En tout cas merci de nous avoir insufflé l’idée, car il y a un cer-
tain temps que je cherchais une solution « anti-spams » sur un 
serveur. La fonction « anti-spams » de Thunderbird est très effi-
cace, malheureusement il y a le temps de téléchargement des 
« spams » et à plus de 50 spams par jour cela devient pénible.

Bernard Ruette

Merci pour votre magazine que je prends plaisir à lire, mais 
deux mois c’est long. La mise en page est simple, aérée  un 
peu comme Ubuntu et c’est ce qui me plaît.  Bonne continua-
tion à votre mag.

Thierry

J’ai installé VLC sur Ubuntu Dapper drake. Cela 
fonctionne pour lire les dvd, mais je suis obligé de 
laisser Totem se lancer ,ensuite bien sûr il ne peut 
lire le dvd,et ensuite je lance VLC. Peut-on faire 
que VLC démarre en premier la lecture du dvd 
sans passer par ce subterfuge ?

Georges (forum Opensource-Magazine)

Opensource-Magazine : En ouvrant Synaptic, si 
vous effectuez une recherche sur VLC, vérifiez que 
libvlc0 est installé ainsi que vlc-nox. D’autre part, 
la plupart des DVD étant désormais protégés, VLC 
a besoin d’une librairie particulière : libdvdcss que 
vous devrez installer « à la main ». Cf opensource-
magazine n°5 p.18 et l’article de ce même numé-
ro consacré à ce sujet précis. Nous évoquons aussi 
en détail ce sujet dans ce même numéro.

Bonne continuation au magazine OpenSource 
dont je ne rate pas un numéro.
Mais il faudrait parler un peu de Fedora car il n’y a 
pas qu’Ubuntu comme distribution....

Olivier Brun

Opensource-Magazine : Message reçu, vous 
trouverez dans ce numéro un article consacré à 
d’autres distributions Linux.

J’ai découvert l’existence de votre ma-
gazine via le site www.linuxfr.org. La pré-
sentation qui est faite de votre magazine 
m’a donné envie de le découvrir davan-
tage.  Frédéric.

Opensource-Magazine : Pour toutes celles 
et ceux qui seraient dans le même cas, un 
numéro gratuit téléchargeable est disponi-
ble sur le site du magazine. Il suffira ensuite 
de nous demander un code d’ouverture 
par mail. 

Est-il possible sur le site d’avoir le sommai-
re des anciens numéros d’Opensource-
Magazine avant de les commander ?  

José Maechler

Opensource-Magazine : Sur le site du 
magazine (www.opensource-magazine.
com) vous trouverez sans problème cet-
te information à la section Forum > Les 
sommaires du magazine. Depuis ce site, 
vous pourrez vous abonner à la revue 
(paiement en ligne) mais aussi participer 
à la vie du magazine en intervenant sur 
le forum. Vous pourrez aussi trouver di-
vers outils disponibles depuis n’importe 
quel navigateur internet et donc depuis 
n’importe quelle plate-forme, Linux, Mac 
ou Windows.

www.opensource-magazine.com

Je suis nouveau sur Linux et sur l’informatique en général. Pouvez vous 
me donner le mode d’emploi des codes pour pouvoir lire le contenu 
des PDF Opensource-Magazine dans l’image iso ?

Jean-Marcel M.

Glissez l’image iso téléchargée depuis notre site sur la fenêtre ouverte 
d’un navigateur internet, Firefox par exemple. Le gestionnaire de fi-
chiers s’activera et vous proposera d’extraire le contenu de l’image 
iso, c’est-à-dire, un fichier PDF du magazine. Lorsque vous tenterez 
d’ouvrir ce fichier avec Evince ou Acrobat, un code vous sera de-
mandé. C’est le code reçu lors de l’achat du magazine ou à la suite 
de la demande du code pour le numéro gratuit.

www.opensource-magazine.com
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Impossible de suivre la plupart des tuto-
riaux d’Open Source Magazine, parce 
qu’à chaque fois, l’installation d’un pro-
gramme coince au même endroit: pas 
de gcc compiler. Pourriez-vous m’indi-
quer où il se planque, ce « gcc compi-
ler » ?  Maguerite

OpenSource Magazine : Le pré-requis obligatoire est d’installer les outils 
développeurs XCode les plus récents si vous travaillez à partir d’un Mac 
sous Mac OS X. Ces outils sont disponibles sur le DVD d’installation du 
système mais la dernière version en date pourra se télécharger depuis 
le site :
http://developer.apple.com/tools/download/
(une inscription, gratuite, est requise)

Si vous travaillez sur un PC ou un Mac sous Linux, il faut installer les outils : 
automake, g+, gcc.
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OpenOffice.org

Comment insérer
une date dans un courrier

Linux§ Windows§ Mac§

La date s’affiche dans le format désiré. Si vous n’avez 
opté pour une date fixe, celle-ci se calera automa-
tiquement à la date du jour à chaque fois que le fi-
chier sera ouvert.

 A l’aide du pointeur de la souris, sélectionnez
une tabulation....1 ...et déplacez-la, en la faisant glisser vers la droite,

jusqu’au point d’insertion souhaité pour la date2

Insérer ensuite au point déterminé la date grâce
au menu Insertion > Champ > Date3 Sélectionnez la date et affichez le menu contextuel 

en combinant les touches CTRL-clic sur la date
(ou clic droit). Sélectionnez l’option : Champs...

4

Sélectionnez le format de date que vous souhaitez. Le 
format fixe permet de conserver la même date quel 
que soit le jour en l’ajustant grâce au champ Correc-
tion des jours (en bas à droite).

5 6
OpenSource Magazine / n° 9 / juin-juillet 200710



OpenOffice.org

Comment insérer
une date dans un courrier

Linux§ Windows§ Mac§

Créer un objet percé en 3D
omment, Avec OpenOffice.org, transformer 
une simple image en objet flottant en trois 
dimensions pourvu d’un hublot ?

- importer une image dans une page Dessin

- dessiner un disque ou un rectangle selon la forme 
de la fenêtre souhaitée

- sélectionner (avec le pointeur) les deux objets en 
les englobant dans le pointillé de sélection

- clic-droit sur le disque (ou le rectangle) pour 
choisir le menu : Formes > Soustraire. L’image est 
percée selon les contour du disque (ou du rectan-
gle)

- sélectionner dans ce même menu contextuel : 
Convertir > 3D

- cliquez deux fois dans l’image pour disposer des 
points rouges d’angles qui permettent de picoter 
l’objet dans l’espace (les repères verts permettent 
de le déplacer)

- clic-droit : Effet 3D permet d’ouvrir la palette des 
réglages de l’objet en trois dimensions

ƒ  Un clic droit et s’ouvre la palette des réglages de l’objet en 3D.

C
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Depuis que je suis passé à la dernière version de Neooffice, 
je bataille avec l’assistant de formules.
Je m’explique : 
Certaines cases contenaient des caratères du style :
Citation :

- DEVIS - ou - dimensions 580 x 352

Du coup je suis obligé de modifier les cellules en formatage 
texte et malgré cela il n’arrête d’ouvrir une fenêtre « Neoof-
fice à découvert une erreur de formule ». 
La question est de savoir s’il est possible de supprimer cet 

assistant de formule pour conserver les tirets qu’il assimile à 
un moins ou les x qu’il assimile au *.

La solution est une astuce Excel  : 
Dans une case formatée « nombre » il faut taper une apos-
trophe avant le texte pour qu’il soit accepté : 
par exemple :
Citation :

‘- dimensions ...

Domd (forum Avosmac)

NeoOffice : maîtriser l’assistant de formules

n°1
en pdf

www.opensource-magazine.com

4 euros par numéro

Commandez-le sur internet :



Linux§ Windows§ Mac§Kexi

es solutions équivalentes aux ges-
tionnaires de bases de données tels 
qu’Access de Microsoft ou Filema-
ker Pro d’Apple sous Linux sont plu-

tôt rares. Kexi est une des solutions à nos 
yeux les plus prometteuses (cf Opensour-
ce-Magazine n°1). Mais elle peine aussi à 
améliorer ses plus gros défauts. 
L’un d’eux, qui n’est toujours pas corrigé 
dans la version 1.1.2 peut être néanmoins 
contourné avec un peu de méthode.

Aussi incroyable que cela puisse paraî-
tre, le simple fait d’ajouter un nouveau 
champ dans une base Kexi provoque, 
au moment de la prise en compte des 
changements, la perte de l’absolue to-
talité des données enregistrées.
Ce problème pourrait rendre Kexi quasi-
ment inutilisable.
Il existe pourtant une solution qui per-
met d’ajouter des champs à une base 
Kexi existante sans perte de données. A 
condition de passer par une phase d’ex-

portation de toutes les données avant 
l’ajout du nouveau champ pour pouvoir 
mieux les réimporter ensuite.

Voici la méthode :

• Procédez avant tout à la sauvegarde 
des données déjà enregistrées dans la 
base à modifier. Utilisez le menu Outils 
(Tools > Scripts > Export Data to XHTML 
File) pour exporter les données sous la 
forme d’un fichier Xhtml. En l’ouvrant 
dans un navigateur internet, vous pour-
rez vérifier que les données ont bien été 
exportées. 

• Lorsque les données sont en lieu sûr, 
vous pouvez procéder à l’ajout du ou 
des champs que vous souhaitez voir figu-
rer désormais dans votre base. Comme 
prévu, la sauvegarde de ces modifica-
tions provoque l’affichage d’un message 
d’alerte qui vous avertit, en anglais, de la 
suppression de toutes les données !

• Une fois les changements effectués, 
utilisez à nouveau le menu Outils (Tools 
> Scripts > Import Data From XHTML File) 
pour cette fois importer les données sau-
vegardées. Il faudra veiller à faire cor-
respondre les champs correctement, 
notamment le champ ID qui n’est pas 
sélectionné par défaut.

• Surprise ! Une fois les données ré-impor-
tées, vous ne les voyez pas s’afficher. Un 
autre gag propre à Kexi. Il faut fermer la 
table puis la rouvrir pour constater que 
l’opération s’est déroulée correctement. 
A ce stade, vous pouvez procéder à 
l’ajout de nouvelles données.

Note : Kexi est disponible par Synaptic 
sous Ubuntu. Sinon les paquets prêts 
à être installés sont disponibles pour 

Fedora (6,5,4), Gentoo, Open-Suse, etc 
depuis le site :

www.koffice.org/kexi/

L

ƒ  Vouloir simplement ajouter un champ dans une base Kexi provoque
        la perte des données ! ƒ  Les données sont enregistrées dans un fichier .xhtml, lisible avec FireFox.

ƒ Une fois les données exportées, vous pouvez ajouter de nouveaux champs.

Utilisez l’outil d’exportation avant tout changement de structure de la base.

ƒ

Kexi : ajouter un champ sans perdre ses données

OpenSource Magazine / n° 9 / juin-juillet 200712



Kexi

ƒ  Le message d’alerte est clair, mais en anglais :
        les données vont être perdues !

ƒ  Confirmation, le contenu de la base a été totalement vidangé !

ƒ  En important vos données exportées dans le fichier .xhtml,
        la récupération de la base est possible.

ƒ  Veillez à bien faire correspondre les champs pour que l’importation
        soit correcte.

ƒ  Les données sont revenues et la table dispose de sa nouvelle structure. 
        Tout va bien !

ƒ  Ne soyez pas circonspect si vous ne voyez rien.
        Fermez la table et rouvrez-la pour constater les changements.

ƒ  Ce message confirme que les données du fichier ont bien été importées 
        dans la table dont la structure a été modifiée.

Kexi : ajouter un champ sans perdre ses données
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Linux§ Windows§ Mac§Kexi

i la base existe déjà dans Kexi et que 
vous avez créé une base contenant ou 
non des données (cf Opensource-Ma-
gazine n°1), le principe est fort simple 

pour créer un formulaire de saisie..

• Sélectionnez à gauche la ligne Forms et 
faites un clic-droit pour créer un objet Form, 
autrement dit, un formulaire (ou déroulez le 
menu Insert > Form). Une page grise s’affiche 
(image 1).

• Dans la colonne de droite, cliquez sur le 
deuxième onglet correspondant à un empi-
lement de disque. Déroulez le menu From’s 
Data Source pour sélectionner la Table d’où 
vont être extraites les données. Les champs 
de cette Table s’affichent alors juste au-des-
sous (image 2).

• Un simple double-clic sur un des champs 
va provoquer la création d’un objet dans 
le panneau gris central. Il s’agit du nom du 
champ et d’un champ de saisie qui contien-
dra la donnée. Répétez l’opération avec les 
champs que vous souhaitez insérer à votre 
formulaire (images 3 et 4).

• Déroulez le menu View > Data view pour 
vous replacer en mode lecture. Vous consta-
terez que les données de votre base s’affi-
chent dans chacun des champs. En bas, vous 
pourrez naviguer avec les flèches bleues et 
même créer de nouvelles fiches avec le bou-
ton + (image 5).

• Vous pouvez même pousser le luxe jusqu’à 
ajouter un bouton auquel vous allez assigner 
une action. En mode édition (menu View > 
Design View), cliquez dans la barre d’outils 
sur l’élément marqué d’un OK (command 
button) puis dessinez avec le pointeur un 
bouton dans le formulaire (image 7). 

• Pour assigner une action à ce bouton, fai-
tes un clic droit sur le bouton et choisissez la 
dernière ligne du menu contextuel : Assign 
Action. Dans le panneau qui s’est affiché, 
sélectionnez à gauche la ligne : Application 
actions. Toutes les actions disponibles s’affi-
chent à droite (image 8).

• Vous pouvez sélectionner : Delete current-
ly selected row. Ceci permet d’assigner au 
bouton l’effacement de la fiche courante et 
ses données. Choisir d’autres actions et ajou-
ter autant de boutons que vous le souhaitez 
(images 9 et 10).

S

Créer un formulaire de saisie pour une base Kexi

ƒ  Commencez par créer un formulaire vierge.

ƒ  A droite, sélectionez la table d’où proviendront les données à afficher
dans le formulaire.

ƒ  En bas à droite, le double-clic sur un nom de champ provoque
sa prise en compte dans le formulaire.

ƒ  Les champs de saisie se comportent comme des objets que vous pouvez
        déplacer dans la page à votre guise.

image 1

image 2

image 3

image 4
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Kexi

Créer un formulaire de saisie pour une base Kexi

ƒ  En mode normal, le formulaire affiche les données de la table.
        Il est possible de les éditer et de naviguer d’une fiche à une autre.

ƒ  Lorsque vous enregistrez les changements, Kexi demande la confirmation.

ƒ  Grâce à l’outil Bouton (marqué par OK) dessinez un objet cliquable.

ƒ  Affectez une action précise à ce nouveau bouton.

ƒ  Choisissez dans la liste l’action que vous souhaitez assigner
        au nouveau bouton.

ƒ  La pression sur le bouton déclenche une action dans cet exemple précis,
        la suppression d’une fiche.

image 5

image 6

image 7
image 10

image 9

image 8
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PHP/MySQL
Linux§ Windows§ Mac§
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Ne pas afficher
les enregistrements doublons

vec une base MySQL, la gestion des doublons est d’une 
déconcertante facilité. Car il existe une simple instruc-
tion pour accomplir cette tâche quelle que soit la lour-

deur de votre base. Nous utilisons cette fonction à la rédaction 
d’OpenSource Magazine lorsque nous envoyons notre note 
d’information aux personnes qui sont abonnées à un de nos 
services (magazine, forum, etc). Ceci afin d’éviter d’envoyer 
plusieurs fois le même mail si ces personnes sont inscrites à plu-
sieurs services.
Le principe est le suivant. Tous les mails sont stockés dans une 
base MySQL. Au moment d’envoyer le message, une clé de 
tri sélectionne un mail unique et évite ses doublons grâce à la 
commande : SELECT DISTINCT 

(voir exemple)

Si le mot DISTINCT n’est pas utilisé, tout le contenu de la base 
est affiché, s’il est utilisé, tous les doublons sont mis de côté. ƒ La commande SQL « Distinct » permet d’évacuer tous les doublons

       lors d’un affichage de données.

A

vec une commande MySQL, com-
ment n’afficher que les 10 premiè-
res fiches d’une base :

SELECT donnee FROM table LIMIT 10;

si vous souhaitez afficher 10 enregistre-
ments à partir d’une fiche situé dans la 

base :
SELECT donnee FROM table LIMIT 1256, 10;

où 1256 est le numéro de la fiche à partir 
de laquelle il faut afficher les données.

Si vous souhaitez afficher les 10 derniè-
res :

ORDER BY id DESC LIMIT 10;
où id est le numéro de la fiche dans la 
base, c’est-à-dire le numéro corres-
pondant à son ordre d’enregistrement 
(ce champ peut porter un autre nom, 
par exemple « user_id » dans le forum 
phpBB).

omment afficher les informations relatives à une table 
d’une base de données MySQL existante, le nom et le 
nombre de ses champs, le nombre d’enregistrements 

qu’elle contient, etc ?

Une commande est dédiée à cette tâche : SHOW TABLE STATUS 
(montrer les statuts de la table). Elle peut s’employer ainsi :

$requete=”SHOW TABLE STATUS”;
$resultat = mysql_query ($requete);

echo “<BR>Voici la liste des tables de votre base<BR><BR>”;

while ($ligne=mysql_fetch_array($resultat))

{
echo “il y a : “.$ligne[Rows].”enregistrement(s) dans la table : 
“.$ligne[Name].”<BR><BR>”;
}

• Pour connaître le nombre de champs :

$requete=”SELECT * FROM nomTable”;
$resultat = mysql_query ($requete);

$champsNb = mysql_num_fields($resultat);

echo “il y a ”.$champsNb.” champs dans votre table”;

• Pour connaître le nom du champ n°2 :

$ListeChamps = mysql_list_fields(“nomBase”, “nomTable”);
$Nomchamp=mysql_field_name($ListeChamps, 2);
echo $Nomchamp;

Vous recherchez d’abord la liste des noms de champs, puis de-
mandez le nom du champ n° 2 et l’affichez enfin. Notez que le 
premier champ est au zéro et non au 1.

Collecter des informations sur la base

C

A
Limiter la sortie à dix enregistrements



PHP/MySQL
Linux§ Windows§ Mac§
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Ne pas afficher
les enregistrements doublons

Effacer directement une donnée 
avec un simple bouton

Collecter des informations sur la base

Limiter la sortie à dix enregistrements

orsque vous affichez le contenu d’une base de données MySQL dans une 
page .php, votre souhait ne se borne pas à lire les informations. Vous pou-
vez vouloir les corriger ou les effacer. Dans ce dernier cas, vous pouvez 

associer à chaque fiche ou enregistrement un bouton d’effacement. Voici une 
manière de procéder.

Il faut d’abord définir la variable $effacer qui générera le bouton associé à un 
des champs de la fiche que l’on souhaite effacer. Dans cet exemple, le champ 
pris en test est un champ appelé « nom ». Mais l’idéal est de créer un champ 
« clé primaire » (primary key) généralement appelé « id » qui s’incrémente 
automatiquement de 1 à chaque nouvel enregistrement. Ainsi, les problèmes 
liés aux doublons sont écartés.
Le bouton est créé par le code HTML habituel :

$effacer=
“<HTML>
<FORM METHOD=’POST’ ACTION=’Effacement.php’>”
.
“<INPUT NAME=’Effacer’ SIZE=’5’ TYPE=’hidden’ VALUE =”.$affichage[‘nom’].”>”
.
“<INPUT TYPE=’submit’ VALUE=’Effacer’>”
.
“</FORM>
</HTML>”;

Une fois cette variable définie, vous demandez à afficher les données de l’en-
registrement, notamment le contenu du champ nom (pour cet exemple) :

echo $affichage[‘nom’];

et vous affichez aussi le bouton d’effacement associé à cette fiche :

echo $effacer.”<br>”;

Lorsque l’utilisateur cliquera sur le bouton correspondant à un enregistrement, 
l’ordre sera envoyé à la page Effacement.php qui contiendra le code à exé-
cuter pour effacer cette fiche :

$nomChamp=”nom”;

$efface = “DELETE FROM $table WHERE $nomChamp=(‘$Effacer’)”;
$resultat1 = mysql_query ($efface);

(voir les deux scripts complets en exemple avec le champ ID comme variable 
de test. Les données sont affichées sous forme de tableau et non avec la com-
mande « echo »)

L

ƒCette page va afficher les données de la base
       sous forme de tableau et créer un bouton d’effacement 
       se référant à l’ID de la fiche.

ƒChaque enregistrement est affiché avec
       un bouton d’effacement qui lui est propre.

Ce code PHP assure
l’effacement de la donnée
une fois que le bouton a été pressé.

ƒ



GEDIT, tu édites
nous éditons
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ors Word de Microsoft, point de sa-
lut ! C’est à peu près ainsi que se 
résumait la situation sur la planète 
traitement de texte il y a quelques 

années. Et puis OpenOffice.org est arrivé 
en version 2 offrant non seulement une 
interopérabilité quasi parfaite avec la 
suite de Microsoft, mais aussi toutes les 
fonctions que l’on peut attendre d’une 
suite bureautique de haut niveau. Cerise 
sur le gâteau, OpenOffice (et son dérivé 
pour Mac, NeoOffice) est gratuit.

Mais pour efficace et puissant qu’il soit, 
OpenOffice.org présente tout de même 
un écueil : il est aussi lourd que Word 
de Microsoft. Parfois, on peut même lui 
reprocher ses allures d’usine à gaz tant 
l’application est richement dotée. On 
peut certes se rabattre sur Abiword, une 
solution libre également, censée appor-
ter des fonctions complètes et compati-
bles avec plus de légèreté. C’est tout de 
même à peine le cas encore.

Et puis lorsqu’il s’agit de saisir des textes 
au kilomètre, pourquoi s’encombrer de 
tels monstres ? A la rédaction d’Open-
source-Magazine on a adopté depuis 
longtemps la solution GEdit, l’éditeur de 
texte de Gnome. Simple, efficace, gra-
tuit, ouvert aux programmeurs, GEdit 

fonctionne à merveille dans une distri-
bution Linux comme sous Mac OS X (par 
MacPorts sous X11, cf Opensource-Ma-
gazine n°8 p.42). 

GEdit (disponible sous Gnome depuis le 
menu Applications > Accessoires > Edi-
teur de texte) sait se contenter de peu 
et sert aux moins exigeants de traite-
ment de texte basique. Il ne dispose pas 
d’outils pour changer rapidement la po-
lice, ne gère pas le gras, le souligné, l’ita-
lique, etc. Voilà pour les inconvénients.

A l’inverse, il dispose de bien des atouts. 
Outre un correcteur orthographique 
classique et une fonction statistiques 
(menu Outils), GEdit dispose d’un moteur 
de recherche permettant de localiser 
un mot dans une page et de le rempla-
cer (menu Rechercher). La casse peut 
être modifiée à la volée (menu Edition 

> Changer la casse). Un outil de tri par 
ordre alphabétique (avec suppression 
possible des doublons) facilite la consti-
tution de listes alphanumériques (menu 
Edition > Trier).

Les concepteurs de sites internet peuvent 
se servir de GEdit pour écrire leur code 
HTML, XHTML, CSS, etc. directement et in-
sérer des balises sans avoir à les saisir. 

Les textes peuvent être encodés en di-
vers formats afin de pouvoir être exploi-
tés sur d’autres plates-formes (lire par 
ailleurs). GEdit supporte intégralement 
l’unicode (UTF-8 et UTF-16).

Enfin, et ce n’est pas là le moindre des 
avantages de GEdit, l’éditeur de texte 
peut être sensiblement enrichi par des 
« greffons » (menu Outils > Outils exter-
nes) dont certains sont déjà installés et 
d’autres peuvent être téléchargés de-
puis le site :

http://live.gnome.org/Gedit/Plugins

Vous pouvez aussi créer vos propres 
commandes et scripts (lire par ailleurs) 
et ajouter ainsi de nouvelles fonctions à 
GEdit.

H

Naviguer dans l’arborescence
epuis les Préférences de GEdit, à l’onglet Gref-
fons, vous pouvez ajouter divers éléments, no-
tamment le Panneau du navigateur de fichiers. 
Il vous donnera accès, depuis le panneau laté-

ral, à l’arborescence de votre disque dur, ceci afin de 
vous faciliter l’ouverture de fichiers dont vous pourriez 
avoir besoin.

D

Dans le panneau latéral, l’arborescence
de votre ordinateur peut être accessible 

grâce à un simple greffon.

ƒ
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orsque vous rédigez un texte avec 
Gedit sous Linux, l’enregistrement 
par défaut a lieu selon la norme 
d’encodage des caractères UTF-

8 (Unicode Transformation Format). 
Votre texte ainsi enregistré peut sans 
problème être rouvert sous Linux avec 
Gedit ou une autre application telle 
qu’OpenOffice.org ou Abiword.

Par contre, si vous transférez ce texte 
ainsi enregistré sur un poste tournant 
avec un système Mac OS X, vous ren-
contrerez un problème d’ouverture 
du fichier si vous utilisez par exemple 
TextEdit au lieu d’OpenOffice.org. Les 
logiciels Apple ne reconnaissent pas 
directement ce format, mais TextEdit 
dispose toutefois d’outils permettant 
d’exploiter le contenu de tels fichiers.

Pour y parvenir, lancez TextEdit, sélec-
tionnez le menu Fichier > Ouvrir et sé-
lectionnez Encodage format texte : 
Unicode (UTF-8) dans le menu dé-
roulant. Puis, recherchez votre fichier 
à ouvrir ou glissez-le dans la fenêtre 
pour sa prise en compte immédiate et 
ouvrez-le. 

Une fois ouvert, il vous faudra le ré-
enregistrer dans le format Occidental 
(Mac OS Roman) ou Unicode UTF-16.

Dans le même ordre d’idées, le format 
Windows est l’ISO 8859-15 également 
proposé en enregistrement par Gedit.

L
Exporter en unicode UTF-8 et UTF-16

ƒ  Gedit est capable d’exporter un texte
        au format UTF-16, universel.

TextEdit d’Apple est capable d’importer
un texte créé en Unicode UTF-8.

ƒ

Ajouter de nouvelles fonctions
n des atouts de GEdit c’est la 
possibilité de lui adjoindre des 
greffons, autrement dit des 
commandes de terminal et des 

scripts shell.

Dans cet exemple basique, nous al-
lons voir comment procéder pour d’un 
seul clic changer un mot précis par un 
autre dans un texte. 
Imaginons que l’on souhaite rem-
placer tous les mots « demain » par 
« aujourd’hui » dans un texte de 15 000 
pages. La commande sera :

sed “s/demain/aujourd’hui/g”

Pour que cette commande puisse être 
intégrée à Gedit, déroulez le menu 
Outils > Outils externes puis cliquez sur 
le bouton Nouveau à gauche, donnez 

un nom à votre greffon et une descrip-
tion. Dans le champ de Commande(s) 
inscrivez :

#!/bin/sh

sed “s/demain/aujourd’hui/g”

Au dessous, sélectionnez :
Entrée = Document actuel
Sortie = Créer un nouveau document 
(ou Remplacer le document actuel)
Applicabilité : Tous les documents

Vous disposerez, une fois le panneau 
fermé, d’une commande automati-

que de remplacement 
des mots par demain par 
aujourd’hui en permanen-
ce. Cette commande sera 
accessible depuis le menu 
Outils.

U

Cette commande « sed » sera
accessible depuis les textes de Gedit.

ƒ

Linux§ Windows§ Mac§
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Exécuter une commande shell
orsque vous déroulez le menu 
Affichage de Gedit, vous pouvez 
afficher le panneau latéral mais 
vous constatez que le panneau 

inférieur n’est pas disponible. Pour l’ac-
tiver il faut ajouter, par exemple, le gref-
fon Outils externe (depuis le menu Edi-
tion > Preferences > Greffons). Il permet 
d’afficher le résultat d’une commande 
de shell lancée avec une des comman-
des externes prêtes à l’emploi dans ce 
greffon. Pour exécuter une commande 
de shell de votre choix, vérifiez en cli-
quant sur le bouton Configurer le Gref-
fon (dans les Préférences > Greffons de 
Gedit) que le raccourci « Exécuter la 
commande » existe. Sinon, vous pouvez 
le créer. Cliquer sur Configurer le gref-
fon et, à gauche, ajoutez un outil en 
cliquant sur le bouton Nouveau. Don-
nez le nom « Exécuter la commande » 
à cet outil, ajoutez-lui une description 
et entrez le code suivant à la rubrique 
Commande (voir image) :

#!/bin/sh

#TODO: use “gconftool-2 -g /desktop/
gnome/applications/terminal/exec”
exec `zenity --entry --title=”Run com-
mand - gedit” --text=”Command to 
run”`

La ligne « Exécuter la commande » sera 
alors disponible dans le menu des Outils 
et lancera un panneau de saisie de la 
commande en question. 

L

ƒ  Vous pouvez créer le greffon s’il n’est pas disponible.

ƒ  Le panneau inférieur de Gedit ne vous sera accessible que si vous activez un greffon
        qui en a besoin, tel que le greffon « Outils externes ».

Ce petit panneau permet de lancer une commande 
de Terminal sans avoir à ouvrir le Terminal.

ƒ

Linux§ Windows§ Mac§
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L existe de bonnes solutions WYSIWYG
open-source dédiées à la création de
pages Web: nous connaissons Mozilla
Composer, NVU, Amaya (qui s'installe
avec fink). Tous trois permettent de

plus un contrôle du code source. Mais enco-
re faut-il s'y entendre en matière de lan-
gage de programmation Web.

Or justement, Bluefish permet de se
familiariser avec les HTML, php, css, etc.,
et de passer ainsi progressivement au mode
expert en proposant  une interface de  pro-
grammation assistée.  En bref, l'utilisateur
n'a pas besoin d'entrer lui-même le code:
des boutons le font à sa place et mettent
le curseur au bon endroit pour saisir le
texte. La coloration syntaxique aide de plus
à y voir clair dans sa page. Bref, le pois-
son bleu est l'outil idéal pour celui qui veut
s'initier à la programmation Web.

Pour commencer, on pourra créer un
nouveau document html (ou xhtml) avec
le démarrage rapide: cliquer sur le menu
Dialogues -> Démarrage rapide. Une fenêtre
s'ouvre qui permet de définir les balises «
Meta ».  La  plus  importante  est celle  qui
définit l'encodage (http-equiv="Content-
Type" content="text/html; charset=UTF-
8"). Ceci fait, le squelette du document est
fin prêt pour recevoir le contenu.

L'application peut être installée via Fink
ou avec DarwinPorts avec la commande
suivante :

$ sudo port install bluefish

Suivant l'état de l'installation de
DarwinPorts sur l'ordinateur, l'opération
peut s'avérer très longue en raison des
dépendances nécessaires à Bluefish. Pour
aller plus loin, voir l'excellent tutoriel de la
non moins excellente revue « GNU/Linux
Pratique », HS n° 1, p.  76-80. Cette revue,
rappelons-le, a pour rédacteur en chef
Denis Bodor, lequel fut également rédac-
teur en chef de l'excellente et très regret-
tée revue « Précision Mac ».

François Giron.

->  http://logiciels-libres-cndp.
ac-versailles.fr/article.php3?id_article=28

Apprendre le langage HTML avec un poisson bleu
S I T E  W E B

1. BlueFish permet de créer un site web.

2. Le
démarrage sert

à créer une pre-
mière page de

base.

3. La programmation en html requiert tout de même
un minimum de connaissances.

4. Le code html de la page est parfaitement clair
avec ses diverses balises de couleur.

i
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anDVD est un outil particulière-
ment souple et efficace pour 
réaliser un diaporama sans gran-
de difficulté ou même un DVD 

complet ! ManDVD s’adresse ouverte-
ment au débutant et ne nécessite aucu-
ne expertise en quoi que ce soit.
Tout au plus doit-on s’assurer au préala-
ble que « dvdauthor » et surtout « dvd-sli-
deshow » sont bien installés. Yum (.rpm) 
ou Synaptic (.deb) peuvent apporter 
leur concours pour cette tâche.

Mode opératoire :

Une fois téléchargé, le logiciel se pré-

sente sous la forme d’un binaire qui 
pourra être lancé depuis une installa-
tion Linux tournant sur plate-forme i386. 
Nous l’avons testé avec succès sous Fe-
dora tournant sur une machine équipée 
d’une puce Intel.

Au lancement de ManDVD (par un dou-
ble-clic sur le binaire), une grande fenê-
tre (parfois trop grande) s’ouvre sur un 
double choix : créer un Nouveau projet 
ou Charger un projet. Au point où vous 
en êtes, autant créer un nouveau projet 
en commençant par sélectionner un ré-
pertoire. Petit conseil de bon camarade, 
créez un dossier dédié à ce travail précis.
Une fois l’étape obligatoire du choix du 
dossier de destination terminée, cliquez 
sur Validez. 

En haut à droite, vous avez encore deux 
choix : Ajouter une vidéo au projet ou 
Créer un diaporama. 

M

ƒ  Double-cliquez sur l’élément mandvd.

ƒ  Nous vous conseillons de créer un nouveau dossier pour le dédier
        à vos travaux avec ManDVD.

ƒ  Ajoutez les images du diaporama et choisissez un effet
        ou une transition à leur appliquer.

ƒ  Deux options sont proposées en haut à droite :
        créer un DVD ou un diaporama.

Commencez
par sélectionner
un dossier 
de destination.

ƒ

ManDVD : créer des DVD et des diaporamas

OpenSource Magazine / n° 9 / juin-juillet 200722



Logiciels

La section vidéo permet de créer un 
DVD à partir de vos propres vidéos en 
y ajoutant des chapitres et des menus 
de manière conviviale et simple. Vous 
ajoutez vos films, vous les coupez éven-
tuellement, vous ajoutez des chapitres, 
des menus, une vidéo d’introduction et 
vous créez au final un DVD qui peut être 
gravé. 

La section diaporama est encore plus 
limpide et concise. 

Une fois la destination choisie, cliquez 
sur Créer un diaporama puis ajoutez vos 
photos en précisant le mode de transi-

tion que vous souhaitez appliquer entre 
les images. Vous pouvez aussi appliquer 
des effets sur chaque image. Veillez à 
régler la durée d’affichage de l’image, 
la valeur par défaut étant un peu juste : 
une seconde.

Vous pourrez ajouter de la musique et 
réaliser un titre grâce au champ dédié. 
Tout est regroupé dans la même page. 
ManDVD propose même de modifier 
vos image dans The Gimp si vous estimez 
qu’elles font à peine l’affaire. 

Lorsque vous jugez que votre diapo-
rama est terminé, cliquez sur Générer. 

Le processus lancera la création d’un 
fichier vidéo .vob lisible avec la plupart 
des lecteurs. Surtout, vous pourrez graver 
un DVD et partager avec vos amis vos 
oeuvres photographiques.

Vous trouverez les différents paquets, y 
compris les sources de ce logiciel conçu 
par Stéphane Gibault, sur le site :

http://kde-apps.org/content/
show.php?content=38347

ƒ  Avant de terminer votre diaporama, vérifiez les derniers réglages. ƒ  Pour créer un DVD, additionnez vos vidéos que vous pouvez 
        sommairement retravailler. Cliquez sur le bouton Suivant
        pour passer à l’étape suivante.

ManDVD construira un projet complet de DVD
qui pourra être gravé.

ƒ

ManDVD : créer des DVD et des diaporamas
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Installer Open-Suse en virtualisation
sur Mac, Windows ou Linux

Linux§ Windows§ Mac§Logiciels

’outil de virtualisation Parallels Des-
ktop (Opensource-Magazine n°4 
p.20) compatible Mac (Parallels 
Workstation pour Linux et Windows) 

présente un gros avantage sur tout 
autre solution. Il permet d’installer sans 
contrainte un autre système d’exploita-
tion que celui présent par défaut sans 
avoir à modifier l’organisation du disque 
dur de la machine. Parallels Desktop 
peut ainsi être utilisé pour installer Linux 
sur une machine équipée de Windows, 
de Linux ou de Mac OS X (sur architec-
ture Intel) sans se soucier de problèmes 
de partitionnement.

Voici la procédure à suivre pour installer 
Open-Suse (une distribution Linux libre sur 
laquelle est basée la distribution com-
merciale : Suse).
Avertissement : lors de la procédure 
d’installation, Parallels desktop est très 
gourmand en ressources et le système 

d’exploitation de base s’en trouve for-
tement ralenti. Une fois l’installation ter-
minée, le fonctionnement est nettement 
plus fluide.

Téléchargez les images de disques iso 1, 
2, 3 et 4 depuis le site (image 1) :

http://fr.opensuse.org/Download

Une fois les quatre images de disque ra-
patriées chez vous, lancez Parallels Desk-
top et créez une nouvelle configuration.
Dans le panneau de bienvenue de Pa-
rallels Desktop, cliquez sur le bouton 
Nouveau pour créer un nouvel environ-
nement, sur Suivant pour accéder à l’op-
tion Personnaliser. 
Dans le panneau qui suit, sélectionnez 
Linux dans le premier menu déroulant et 
Suse dans le second (image 2). Ajustez 
ensuite la mémoire à 600 Mo au maxi-
mum puis créez une nouvelle image de 

disque dur de 32 Go, soit 32 000 Mo. Lais-
sez l’option Extensible cochée. Ce choix 
permettra de ne pas vous soucier par la 
suite de la taille du disque dur virtuel as-
socié à Open-Suse, il grandira selon les 
besoins !
L’emplacement du disque virtuel peut 
être conservé par défaut. Paramétrez le 
profil de votre réseau et donnez un nom 
à votre configuration, par exemple Suse.

Au moment où l’on vous demande d’in-
sérer le CD d’installation, cliquez sur le 
triangle « plus d’options » afin de choisir 
Image ISO (image 3) si vous n’avez pas 
gravé sur CD les images téléchargées. 
Parallels Desktop est tout à fait en me-
sure de prendre en compte ce type de 
média. 
Cliquez sur le bouton Choisir pour aller 
sélectionner l’image de disque Suse n°1 
(image 4). Cliquez sur Terminer.

L

image 1 image 2 image 3

image 4

ƒ Téléchargez les disques nécessaires
       pour installer Open-Suse.

ƒ Sélectionnez le type de système d’exploitation 
       et la version utilisée.

ƒ Si vous utilisez des fichiers .iso plutôt que
       des CD gravés, cochez la case « Image ISO » 
       après avoir cliqué sur « Plus d’options ».

Recherchez et sélectionnez
les images de disque.

ƒ
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Un écran d’Open-Suse doit apparaître.
Cliquez à l’intérieur de la fenêtre pour 
que le pointeur de la souris soit pris en 
compte dans ce nouvel environnement. 
Pressez la touche de validation ou pa-
tientez quelques secondes pour que 
l’installation démarre.

Lorsque la commande boot paraît, saisis-
sez la commande (image 5) : 

linux

Ensuite, une interface graphique permet 
aisément de sélectionner tour à tour :

- choix de la langue
(à chaque fois, cliquez sur Suivant en bas 
à droite pour avancer dans le processus 
d’installation)
- vérification du support (disque dur in-
terne de votre ordinateur)
- acceptez la licence d’utilisation

- choisir le type d’installation (nouvelle, 
mise à jour ou autres)
- sélectionnez le fuseau horaire
- choisir l’environnement du bureau 
(Gnome ou KDE)
- partition automatique (tout le disque 
est effacé) ou expert (si vous savez ce 
que vous faites)

L’installation des éléments du système 
démarre automatiquement après le par-
titionnement du disque. 

En cours d’installation, le processus sera 
stoppé net par la nécessité d’introduire 
le disque 2. Or, il s’agit d’images virtuel-
les. Pour que le deuxième fichier iso soit 
pris en compte, combinez les touches 
CTRL-ALT qui permettent de sortir le poin-
teur de la souris de l’écran de virtualisa-
tion et déroulez le menu Périphérique > 
CD/DVD-ROM > Connecter une image, 
afin de choisir l’image n°2 (image 6). Et 

ainsi de suite pour les images 3 et 4 lors-
qu’elles vous sont demandées. 

Arrivé presque au terme de l’installa-
tion :

- définissez le mot de passe de l’adminis-
trateur (root) du poste (image 7)
- effectuez éventuellement la mise à jour 
des éléments (vous pourrez le faire plus 
tard)
- vous pouvez ensuite personnaliser le 
nom de l’hôte
- définissez le profil de l’utilisateur

Que vous ayez choisi l’environnement 
de travail Gnome ou KDE, le système re-
démarre automatiquement et vous offre 
la possibilité de travailler enfin avec un 
système Linux (image 8).

http://fr.opensuse.org
http://fr.opensuse.org/Download

Parallels Workstation et Parallels Desktop : 
www.parallels.com

ƒ Tapez linux à la commande Boot ou patientez 
      quelques secondes.

ƒ Sélectionnez les images de disque au fur et à mesure des demandes de l’installateur.

Linux tourne
de manière fluide 

avec Parallels 
Desktop.

ƒ

Définissez un profil 
d’utilisateur.

ƒ

image 5 image 6

image 7 image 8
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Columba, un client 
email sécurisé

Linux§ Windows§ Mac§

L'interface de rédaction des mails
est on ne peut plus classique et complète.

ƒ

olumba est un client de courrier 
électronique, libre programmé 
en Java à la fois très souple 

d’utilisation et puissant. Il cumule toutes 
les fonctions d’un Outlook Express avec 
le support des comptes POP3 et IMAP 
et le suivie de messages (confirmation 
d’envoi et accusé de réception). 
En matière de sécurité, cette application 
gère les spams (courriers non sollicités) en 
étudiant et en mémorisant vos habitudes 
de filtrage et en les isolant dans un 
dossier à part. Il est aussi possible d’établir 
de l’échange des communications 
électroniques sécurisées via le module 
Open PGP (Pretty Good Privacy) intégré. 
Les nouveaux utilisateurs ont la possibilité 

d’importer leurs anciens comptes et leurs 
messages pour les principaux clients 
emails que sont Eudora, Netscape, 
Outlook Express. Il est également 
très facile d’importer dans le carnet 
d’adresses vos contacts et vos cartes de 
visite aux formats VCARD, CSV (fichiers 
dont les champs sont séparés par un 
caractère), et LDIF (Mozilla). En dehors de 
son aspect esthétique particulièrement 
réussi, notamment avec la disposition 
des fenêtres sur trois colonnes très utile 
pour plus de lisibilité sur les moniteurs 
16/10ème, l’application supporte les 
thèmes d’habillages graphiques. Mais, 
la grande richesse de ce client email 
repose surtout sur la quantité de plugins 

existants. Ainsi, en ajoutant « French 
Vanilla Calendar » l’interface se dote 
d’un calendrier façon Outlook 2003/07 
qui vous permettra d’inscrire vos tâches 
et rendez-vous importants. On peut 
également « greffer » un dictionnaire 
de vérification orthographique dans la 
langue de son choix (Spell checking), 
installer un module de t’chat ou enfin 
éditer sa signature pour chaque courrier 
sortant.

Jean-Christophe Bonalair.

Nom : Columba
www.columba.sourceforge.net

Version : 1.2
OS : Windows, Linux

Si vous souhaitez changer de logiciel de messagerie, le 
moment est sans doute venu de migrer vers Columba. 

Ce dernier gère les spams, les emails cryptés et 
possède même un calendrier pour vos rendez-vous.

C

ƒColumba cumule les fonctions d'Outlook de Microsoft tout en étant libre. ƒColumba supporte de nombreux plugins qui apportent de nouvelles 
       fonctions à l'instar de ce calendrier disponible
       avec « French Vanilla Valendar ».
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pas
à

pas… 1 En premier lieu téléchargez et installez le kit de ressources 
JAVA à l’adresse suivante www.java.com/fr. Après avoir 
installé Columba récupérez dans la section Download 

et Translation le patch de traduction en français nommé 
langpack_fr.jar. Copiez ce fichier dans Program Files\Columba. 
Au lancement de Columba activez la langue dans Edit, General 
Options, Language. Puis redémarrez l’application (image1).

2 Pour installer un compte email, cliquez sur Editer, Comptes 
de messagerie et Ajouter. Vous voici dans l’Assistant de 
Création de comptes. Il suffit à présent de renseigner les 

champs Nom, adresse email et nom du compte (image2). 
3 A présent saisissez votre login ainsi que le serveur de fichiers 

entrants POP3 ou IMAP. Et, dans l’écran suivant le serveur 
d’envoi de fichier SMTP (image 3).

4 Retournez dans Editer, Comptes de messagerie mettez 
en surbrillance votre compte puis cliquez sur Editer. Dans 
l’onglet Options de réception cochez Envoyer/Recevoir 

à intervalles réguliers et Emettre un son lors de la réception de 
nouveaux messages (image 4).

5 Sélectionnez à présent l’onglet Spam Filter et cochez 
Enable adaptative spam filter. Ceci déclenchera le 
programme d’apprentissage des courriers fiables et 

indésirables dans Columba (image 5).
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’avènement de l’informatique puis l’ouverture du réseau in-
ternet ont donné un coup d’accélérateur sans précédent 
à la recherche généalogique. Depuis un simple Mac ou un 
PC, que ces machines tournent sous Mac OS X, Windows ou 

même Linux, il est tout à fait possible de s’adonner à son passe-
temps en bénéficiant de la puissance de feu de l’informatique. 
Dans le domaine des logiciels de généalogie disponibles, il y a 
quelques grands noms et une kyrielle d’alternatives plus ou moins 
heureuses. 

Si vous souhaitez une solution peu contraignante pour vos finan-
ces personnelles, vous pouvez adopter Geneweb, une solution 
libre aussi puissante que facile à utiliser. 

Dans les quelques lignes qui suivent, nous allons expliquer les 
grands principes de Geneweb et vous guider pour en exploiter 
les principales fonctions. Geneweb est un outil qui fonctionne par 
l’entremise d’un navigateur internet, ce qui lui permet d’être dis-
ponible sur toutes les plates-formes. 

Récupérer le logiciel Geneweb disponible en téléchargement 
gratuit : 

• version Mac OS X :
www.geneweb.org/ftp/MacOSX/
(cliquez sur : gw-4.10-macosx.zip
ou gw-5.00-macosx.tgz)

• version Windows : 
www.geneweb.org/ftp/Windows/ 
(gw-4.10-win.exe )

• version Linux : 
www.geneweb.org/ftp/Linux/
(sélectionner Debian ou RPM selon votre distribution)

• sources à compiler : 
www.geneweb.org/ftp/Src/

Installation

Geneweb ne nécessite pas de travaux très contraignants pour 
être opérationnel, juste un peu d’attention. Il faut d’abord créer 
un répertoire de bases généalogiques. Voici comment procéder.

Sous Mac OS X, avec la version 4.10 c’est plutôt simple. Com-
mencez par double-cliquer sur l’élément « GeneWeb.command » 
(image 1) qui lance dans le Terminal, un script d’activation du ser-
veur de pages web en local. Il ouvre directement la page dans le 
navigateur (image 2). Cliquez sur le lien : http://127.0.0.1:2316/ et 
c’est parti ! (lire ci-après la section Démarrage)
Si vous préférez utiliser la version 5 sous Mac OS X, ouvrez le termi-
nal, tapez la commande cd, faites une espace et glissez le dossier 
gw-5.00-maxosx à la suite et validez. Puis glissez dans le terminal 
l’élément gwsetup qui se trouve dans le dossier gw-5.00-maxosx 

L

ƒ  Sous MacOS X, un script automatise le lancement des commandes 
        gwsetup et gwd dans la version 4.10

ƒ  Une fois gwsetup lancé depuis le Terminal, cliquez sur l’un des deux 
        liens proposés qui conduisent sur la même page de configuration.

ƒ  Sélectionnez la langue, puis cliquez sur le lien « Méthode simple ».

image 1

image 2

image 3

Geneweb : la généalogie à la portée de tous
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et validez. Tapez fr, à la suite du point d’interrogation et validez. 
Le serveur est lancé. Cliquez sur l’élément Start.html qui se trouve 
dans le dossier gw-5.00-maxosx. Sélectionnez votre langue et sui-
vez les instructions.

Sous Linux : les paquets pour plates-formes Intel existent pour De-
bian (Ubuntu), Redhat (en rpm et sources rpm) et pour Mandriva. 
Si vous travaillez sous Ubuntu (ou un de ses dérivés), Geneweb 
est disponible par Synaptic ou Adept. Installez non seulement Ge-
neweb mais aussi Gwsetup pour préparer la base et Gwtp.
Mais nous trouvons en définitive plus simple de partir des sources 
(lire plus loin).

Sous Windows : un fichier zippé est également disponible.

Démarrage

Le lancement de Geneweb se fait en deux étapes. Nous verrons 
ensuite comment éviter la première étape. 
Il faut normalement d’abord lancer depuis le terminal l’utilitaire 
gwsetup (pour sélectionner la langue) puis gwd. 
Sous Linux comme sous Mac, cette opération peut être automa-
tique.

Sous Mac OS X, le double-clic sur « GeneWeb.command » (image 
1) se charge de ces deux opérations. Une page du navigateur 
internet s’ouvre (image 2) et propose de sélectionner le lien : 
http://127.0.0.1:2316/ 
Il ouvre sur la page d’accueil de Geneweb où vous devez sélec-
tionner la langue puis cliquer sur le lien : « Pour les débutants, voici 
une méthode simple pour démarrer » (image 3). A moins que vous 
n’ayez déjà la maîtrise du sujet.

Il vous faudra ensuite créer une base réservée à vos données gé-
néalogiques (image 4). Par défaut, cette base s’enregistre dans le 
dossier GeneWebBases créé sur le bureau (sous Mac OS X avec la 
version 4.10) et s’appelle « base » (ou directement dans le dossier 
distribution de Geneweb pour les autres versions et autres systè-
mes). Vous pouvez changer ce nom de «base» si vous le désirez. 

Cliquez sur Créer dans tous les cas pour démarrer et créer cette 
fameuse base de données qui abritera le résultat de vos futurs tra-
vaux généalogiques. Le lien direct à cette base (image 5) sera :
http://127.0.0.1:2317/base (sauf si vous l’avez appelée d’un autre 
nom que base).

Nous vous conseillons à ce stade de créer un raccourci avec cet-
te adresse internet pour accéder directement à votre base sans 
passer par les étapes précédentes. Une fois l’adresse saisie dans 
le navigateur internet, sélectionnez-la et glissez-la vers le bureau 
pour créer un raccourci de page web.

Sous Linux : Si vous avez opté pour la compilation des sources, 
vous avez suivi les différentes étapes et vous disposez donc d’un 
répertoire Distribution dans le dossier geneweb-5.00. Ouvrez ce ré-
pertoire et double-cliquez sur l’élément Start.htm pour paramétrer ƒ  Remplissez les champs selon les éléments dont vous disposez

        et validez.

ƒ  Créez une première famille à partir de cette page d’accueil
        de votre base généalogique.

ƒ  Donnez un nom à votre répertoire de base généalogique
        et cliquez sur Créer.

image 6

image 5

image 4

Geneweb : la généalogie à la portée de tous
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et créer la base de départ. Ensuite, lancez gwd au terminal et 
saisissez l’adresse :
http://127.0.0.1:2317/base

Démarrage

Dans la page d’accueil de votre base généalogique, la com-
mande importante est : « ajouter une famille » (image 5). Elle per-
met, comme son nom l’indique, d’ajouter un nouveau couple et 
ses enfants. S’il s’agit d’un individu seul que vous souhaitez ajou-
ter, bornez-vous à ne remplir que le champ correspondant (Lui 
ou Elle) (image 6). Si cet individu est célibataire ou que vous ne 
connaissez pas sa situation de famille, créez la fiche quand même 
et validez (soit avec le bouton qui se trouve en pied de page, soit 
en pressant la touche Entrée dans un champ de saisie).
Une fois dans la page intitulée « Famille ajoutée » vous pouvez édi-
ter la fiche en cliquant sur un des deux liens associés aux individus 
(image 7). Lorsqu’un seul nom a été entré, l’autre s’affiche sous 
forme de points d’interrogation. S’il s’agit d’un célibataire, cliquez 
sur le lien « ?? » pour éditer le profil de la personne (image 8) puis 
cliquez sur « Mise à jour » et enfin sur « Supprimer la famille » et OK 
(image 9). Répétez l’opération toujours sur « ?? » pour supprimer 
ensuite la personne.
L’individu devient alors vraiment sans alliance et sans descendan-
ce. Pour revenir au départ, cliquez sur la flèche jaune dirigée vers 
le haut ou sur l’arbre vert, logo de Geneweb (en bas à droite). 
Pour retrouver l’individu, entrez son nom exact dans le premier 
champ de saisie de la page d’accueil (image 5). 
La liste des individus de même nom s’affiche en arborescence 
(image 10). Cliquez sur l’un d’eux pour ajouter un conjoint, des 
enfants, modifier et compléter les fiches par le biais de la com-
mande « mise à jour ».
Si un individu est seul, et qu’il se marie, il faut utiliser la commande 
« Créer une famille ». Vous pouvez lui « Ajouter des parents » si vous 
en avez connaissance. La commande « Fusionner » permet de 
confondre deux fiches qui correspondent en définitive au même 
individu. 
Il est possible d’« Ajouter un mariage » si la personne s’est mariée 
plusieurs fois. Pour ajouter des enfants, cliquez sur « Modifier fa-
mille » (image 11).
Grâce à ces quelques commandes, votre arbre se construit petit 
à petit.  A chaque fois que vous ajoutez un nom, vous avez le 
choix entre Créer une fiche ou la Relier à une fiche existante. Un 
célibataire peut ainsi être Relié à une famille une fois le lien de 
parenté établi.

Aller plus loin

Lorsque le contenu de la base s’étoffe, la lecture en arborescen-
ce (image 10) peut devenir vite trop lourde. Pour afficher cette 
arborescence, il faut cliquer sur le nom patronymique qui s’affiche 
en haut de la page. 
Il existe plusieurs options pour synthétiser l’information et des fonc-
tions de tris particulièrement puissantes.
Affichez d’abord la fiche d’un nom pour pouvoir accéder aux 
commandes : ascendants, descendants, cousins, frère suivant, 
calcul de parenté (image 11). Si vous souhaitez travailler sur les 
descendants, cliquez sur le lien correspondant. Vous êtes dirigé 
dans une fenêtre de réglages d’où vous pourrez choisir le mode 
d’affichage (image 12). Le plus visuel est l’affichage en arbre gé-
néalogique (image 13) mais il existe d’autres options telles que 
l’affichage par familles, d’Aboville, etc.

ƒ  Depuis cette fiche d’individu, vous pouvez modifier et compléter
        ses informations et celles de son couple.

ƒ  Si votre homme n’a pas de conjointe, cliquez sur Mise à jour pour 
        accéder aux commandes d’effacement d’individu et de famille.

ƒ  La fiche individuelle propose dans sa section Mise à jour
        les principales commandes d’édition.

ƒ  La liste des individus de même nom et de la même famille
        s’affiche en liste chronologique.

image 7

image 8

image 9

image 10
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Exporter et publier

Depuis Geneweb il est possible de rapatrier des données enregis-
trées au format standard GEDCOM ou de réaliser l’opération in-
verse pour exporter des données de Geneweb vers un autre outil 
de généalogie. Pour ces opérations, il faut se servir des utilitaires 
présents dans le dossier gw du répertoire Geneweb : gwb2ged 
(pour convertir du format Geneweb vers le format Gedcom), 
ged2gwb (pour convertir depuis le format Gedcom vers le format 
Geneweb). Le principe est simple mais nécessite d’en passer par 
le terminal.
Ouvrez le terminal, glissez l’élément gwb2ged puis glissez à la suite 
la base à convertir en Gedcom. Il s’agit du répertoire complet 
présentant le suffixe .gwb. Supprimez le dernier slash pour obtenir 
une ligne de commande dans ce genre (image 14) :

gwb2ged /Users/opensource/Desktop/GeneWebBases/LeMastin.
gwb 

Vous récupérerez le fichier a.ged dans votre répertoire personnel 
(dans la maison sous Mac OS X).

A l’inverse, le fichier Gedcom sera converti ainsi :

ged2gwb /Users/opensource/a.ged

Une fois le répertoire a.gwb obtenu, renommez-le sous un nom 
plus explicite en conservant le suffixe .gwb. Glissez-le dans votre 
dossier de bases généalogiques avec les autres dossiers .gwb de 
même nature. Il faudra ensuite modifier l’adresse d’accès depuis 
le navigateur en indiquant le nom de la NouvelleBase :

http://127.0.0.1:2317/NouvelleBase

ƒ  Cliquez sur Ascendants ou Descendants pour dessiner
        l’arbre généalogique.

ƒ  Cochez l’option Arbre et sélectionnez le nombre de générations
        à afficher dans le menu déroulant avant de cliquer sur OK.

ƒ  La présentation en arbre généalogique donne une jolie
        vision synthétique de vos travaux.

ƒ  Geneweb est livré avec des utilitaires de conversion pour se rendre 
        compatible avec le standard GEDCOM.

Les liens
www.geneweb.org
http://cristal.inria.fr/~ddr/GeneWeb/

www.heredis.com/fr/

Un excellent site de recherche de patronymes, 
d’arbres généalogiques et d’extraits de docu-
ments (gratuité partielle) :

www.geneanet.org/

image 14

image 13

image 12

image 11

OpenSource Magazine / n° 9 / juin-juillet 2007 31



Linux§ Windows§ Mac§Application Internet

vant de compiler Geneweb à partir des sources, 
vous devez avoir installé Ocaml (pour le support 
du langage ML) et ocaml-native-compiler. Ocaml 
est disponible pour Mac OS X et Linux (sous Ubuntu 

avec Synaptic).

Une fois les sources de Geneweb téléchargées, décom-
presser l’archive pour obtenir un dossier geneweb-x.xx.

Dans le terminal, entrez la commande :

cd

faites une espace et glissez le dossier geneweb-x.xx à la 
suite. Validez et saisissez les commandes :

./configure

(il ne doit rien se passer de particulier)
puis

sudo make

et enfin

make distrib

Sous Linux (ou Mac OS X), lancez la première fois Gwse-
tup qui se trouve dans le dossier Distribution du répertoire 
Geneweb (image 1). Soit vous double-cliquez simplement 
dessus (sous Linux), soit vous vous placez d’abord dans le 
dossier qui contient cette commande puis vous lancez la 
commande.
Répondez à la question en saisissant fr au terminal (image 
2) puis double-cliquez sur l’élément Start.htm qui se trouve 
dans le dossier Distribution. Une fois la base créée de ma-
nière classique (lire par ailleurs), quittez gwsetup par CTRL-
C puis lancez le daemon gwd au terminal.

Sous Linux (ou Mac OS X), le daemon gwd est normalement 
lancé automatiquement. Si ce n’est pas le cas, ouvrez une 
fenêtre de Terminal et entrez la commande : 

cd 
et, après une espace, glissez l’élément gwd qui se trouve 
dans le dossier Distribution (dans le répertoire Geneweb-
x.xx). Validez pour lancer ce daemon obligatoire. Sans 
quoi, vous ne réussirez pas à vous connecter au serveur 
de vos bases généalogiques (image 3). Vous pouvez aussi 
essayer de double-cliquer directement sur l’élément gwd 
pour lancer la commande dans le terminal (image 4).

Dans un navigateur, entrez l’adresse :

htpp://127.0.0.1:2317/NomBase

où NomBase est le nom de votre base. Veillez à créer un 
lien direct avec cette page par glisser/déposer de l’adres-
se sur le bureau (image 5).

ƒ Une fois les sources compilées, ouvrez le dossier Distribution
       pour y découvrir les outils de gestion de Geneweb.

ƒ  Répondez « fr » à la commande gwsetup, puis lancez gwd
        et laissez le Terminal ouvert.

Geneweb, à la source

A

Note : L’utilitaire gwc sert à créer
des bases depuis le terminal. Il ne vous est normalement pas utile.

http://caml.inria.fr/ocaml/release.fr.html

image 1

image 2
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ƒ  Pour se connecter aux bases généalogiques de Geneweb, il faut 
        nécessairement avoir lancé gwd, sans quoi vous obtiendrez ce message.

Geneweb, à la source

ƒ  Sous Ubuntu, vous pouvez vous contenter de double-cliquer sur les scripts 
        gwsetup et gwd pour les « lancer dans le Terminal ».

image 4image 3

Créez un raccourci 
de la page accédant 

directement à votre 
base pour gagner

du temps à l’ouverture.

ƒ
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Trop d'intrus sur les
forums ? Supprimez-les

Linux§ Windows§ Mac§

a mise en place d’un forum pour 
les visiteurs de votre site est un des 
buts ultimes de votre existence sur 

internet. Le problème est que certaines 
solutions présentent certes de gros avan-
tages et de nombreuses fonctions mais 
sont aussi à la merci des importuns et 
autres participants indélicats. Si comme 
la rédaction du magazine, vous avez mis 
en place un forum phpBB en version 2, 
vous êtes sans doute attaqué régulière-
ment par des intrus dont le but essentiel 
est de promouvoir des sites pornographi-
ques ou de vente de médicaments ou 
autres joyeuses plaisanteries du même 
tonneau. 
Nous avons évoqué dans un précédent 
numéro la technique pour éviter déjà 
à ces intrus d’afficher le lien de leur site 
internet lorsqu’on demande leur profil. 
Maigre consolation. Si leur compte est 
activé, ils peuvent rattraper le coup en 
postant un message contenant un tas 
de liens vers leurs sites indésirables. 
La solution consiste à faire confirmer 
chaque inscription par l’administrateur 
(donc vous) et non plus par l’utilisateur 
lui-même. Mais pour intéressante qu’elle 

soit, cette solution reste vague. Vous re-
cevez un mail de demande de confir-
mation ou de suppression qui n’indique 
que le pseudo du candidat au forum. 
C’est largement insuffisant.
Aussi, nous avons conçu une méthode 
qui a le mérite d’être très efficace. Avant 
de confirmer un pseudo, nous affichons 
dans une page diverses informations qui 
nous aident à nous faire notre jugement : 
pseudo, mail, lien vers le site web, test de 
ce lien, pays d’origine, numéro d’inscrip-
tion (ID) et état du compte.
La nature de l’adresse mail peut déjà 
inciter à la méfiance. Orange, Free, La-
poste, etc sont évidemment moins sus-
pects qu’un please-email-me.info ou un 
truc interminable. Si l’utilisateur inscrit UK, 
USA, RU, etc, vous pouvez douter de l’in-

térêt qu’il porte vraiment à un site fran-
çais. Mais le dernier test implacable est 
de vous rendre sur son site web s’il a ins-
crit une adresse. Si vous n’y parvenez pas 
ou si le site est en anglais ou encore pré-
sente un contenu qui ne vous plaît pas, il 
ne vous reste plus qu’à effacer l’intrus en 
saisissant tout simplement son numéro ID 
d’identification. 
Avant même d’avoir confirmé son inscrip-
tion vous évacuerez l’individu qui pourra 
certes relancer son robot pour effectuer 
une nouvelle inscription. Mais vous aurez 
de la sorte toujours le dessus en connais-
sance de cause.

Cette méthode est assez simple à mettre 
en œuvre et ensuite très souple à utiliser. 

ƒCette simple page affiche l'essentiel pour se faire une idée sur la nature du candidat.

L

ƒCe code va permettre d'effacer de la base l'intrus en saisissant
       son numéro d'inscription (ID).

ƒ

Cette page permet d'afficher les candidats
à l'inscription sur le forum les plus récents

OpenSource Magazine / n° 9 / juin-juillet 200734



Trop d'intrus sur les
forums ? Supprimez-les

Open-Suse : installer
de nouveaux logiciels

Linux§ Windows§ Mac§ Astuces

omment installer de nouveaux 
logiciels lorsqu’on travaille dans 
l’environnement Open-Suse sous 
KDE ou Gnome ? 

Par défaut, les concepteurs de cette 
distribution Linux libre ont prévu un outil 
d’installation de logiciel qui se lance, 
sous KDE, depuis le menu Suse >Appli-
cations > Système > Configuration (sous 
Gnome : cliquez sur Ordinateur en bas à 
gauche puis sélectionnez : Installation de 
logiciels). 
Simple d’emploi, il suffit de cocher la 
case qui correspond au logiciel à instal-
ler puis de valider (et d’être connecté 
à internet) pour que l’opération ait lieu 
d’un bout à l’autre. 
Mais cette facilité a aussi son revers. La 
liste des logiciels disponibles ainsi est bien 
maigre. 

L’idéal alors pour en ajouter est de trou-
ver le paquet RPM qui correspond au lo-
giciel sur internet. Dans un moteur de re-
cherche, la mention du nom du logiciel + 
rpm, devrait vous permettre de localiser 
ces éléments. Vous pouvez aussi explorer 
le site suivant :

http://rpmfind.net/linux/RPM/
sourceforge/s/su/suserpm/

en quête de la perle rare.
Une fois le paquet RPM téléchargé, uti-
lisez l’outil «Installation de logiciel» fourni 
avec cette distribution Suse.

Faites un clic-droit sur l’icône du paquet 
et allez sélectionner l’utilitaire Installation 
de logiciels qui se chargera alors d’instal-
ler le logiciel en prenant en compte ses 
dépendances.

Vous pouvez aussi installer de nouveaux 
logiciels en téléchargeant leurs sources 
non compilées, à condition d’avoir ins-
tallé au préalable les outils de compila-

tion (gcc, g++, etc). Lorsque ces sources 
sont chargées, il faut décompresser l’ar-
chive, puis entrer la commande :

cd

au terminal et glisser à la suite (après 
une espace), le dossier des sources dé-
compressées et valider. Entrez ensuite les 
commandes :

./configure

puis : make 

et enfin : make install

C

ƒCe panneau veut faciliter la navigation. Il ne fait que rendre plus nébuleux le fonctionnement.

ƒ  Cochez le logiciel que vous souhaitez 
        installer puis validez.
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ous Ubuntu ou une autre 
distribution Debian, l’outil 
indispensable pour gérer, 
installer, supprimer et met-

tre à jour des logiciels, c’est Sy-
naptic. Cet outil est en fait une 
interface graphique destinée à 
piloter un autre gestionnaire qui 
fonctionne, lui, en mode termi-
nal : Apt (adept package ma-
nager).

Mais si Synaptic gère à merveille 
les paquets de type .deb, il sait 
aussi, et c’est moins connu, gé-
rer des paquets .rpm (depuis le 
lancement de apt-rpm). Vous 
pouvez ainsi activer Synaptic 
dans une distribution Fedora et 
tenter l’installation de nouveaux 
logiciels. 
Sans doute serez-vous déçu par 
la maigre liste des paquets dis-
ponibles : moins de 10000. Ainsi, 
ne comptez pas installer VLC 
avec Synaptic sous Fedora, le 
logiciel n’est pas disponible di-
rectement, même en ajoutant 
les dépôts non pris en compte 
par défaut. Vous devrez passer 
par Yum (lire par ailleurs).

Lorsque Synaptic est installé, ren-
dez vous dans le menu Configu-
ration > Depôts. Si vous avez ins-
tallé Ubuntu, vous allez pouvoir 
vous contenter de cocher des 
cases dans les onglets Ubuntu 
Logiciels et Mises à jour, voire 
Logiciels de tierces parties. Ce 
même panneau est accessible 
depuis le menu Système > Ad-
ministration > Sources de mises 
à jour. Pour ajouter une adres-
se de téléchargement à faire 
prendre en charge par Synap-
tic, allez dans l’onglet Logiciels 
de tierce partie, cliquez sur le 
bouton Add et saisissez l’adres-
se spécifique où est maintenu le 
logiciel, par exemple : 

deb http://archive.ubuntu.com/
ubuntu/feisty main

S

ƒ  Sous Ubuntu, tout est prévu pour faciliter le travail de l’utilisateur. Vous pouvez ainsi tout cocher
        pour ne rien rater, y compris les codes sources.

ƒ  Un conseil, veillez à bien installer les mises à jour de sécurité régulièrement.

Synapic installe les paquets .deb
mais aussi les .rpm
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http://apt-rpm.org
www.nongnu.org/synaptic

Pour les dépôts, voir :

http://doc.ubuntu-fr.org/depots/edgy

Une fois les adresses des nou-
veaux dépôts ajoutées, cliquez 
sur le bouton Recharger afin 
que les ressources de ces nou-
veaux dépôts soient prises en 
compte dans les listes logiciels 
disponibles avec Synaptic.

Ensuite, la mise en route est ba-
sique. Saisissez le nom du logi-
ciel dont vous souhaitez profiter 
et lancez la recherche. Les élé-
ments (les dépendances) né-
cessaires et complémentaires à 
l’application demandée seront 
installés en même temps.

Dans tous les cas, le logiciel 
pourra être lancé en saisissant 
son nom depuis le Terminal. 
La plupart du temps, s’il s’agit 
d’une application disposant 
d’une interface graphique, elle 
sera accessible depuis le menu 
Applications dans la rubrique 
correspondant à son thème.

La dernière version en date de 
Synaptic est ancienne. Elle date 
de 2005 et est numérotée 0.56.

La variante disponible pour KDE 
est Kynaptic.

Les commandes de terminal 
équivalentes à Synaptic sont :

apt-get update

pour mettre à jour la liste des 
paquets disponibles aux dépôts 
référencés dans Synpatic (menu 
Configuration > Depots).

apt-get install inkscape

installe le logiciel Inkscape.

ƒ  L’ajout d’adresses de nouveaux dépôts est possible dans la section Logiciels de tierces parties.

ƒ  Sous Fedora, Synapic gère les paquets .rpm mais l’utilitaire est moins convivial.

ƒ  Saisissez l’adresse du nouveau dépôt et validez.

Synapic installe les paquets .deb
mais aussi les .rpm
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i vous utilisez Fedora plutôt qu’Ubuntu, vous devez gérer 
des paquets .rpm en lieu et place de paquets .deb. 

Sous Ubuntu, environnement Gnome, vous avez sans 
doute pris la bonne habitude de gérer l’installation de nou-
veaux logiciels avec l’outil Synaptic (ou ses équivalents Ky-
naptic ou Adept sous KDE). Cet utilitaire installe non seulement 
le logiciel souhaité par vous, mais aussi la kyrielle d’éléments 
qui lui sont nécessaires pour fonctionner, autrement dit, les 
« dépendances ».

Comment obtenir le même service sous Fedora (environne-
ment Gnome ou KDE) ?

Il existe tout d’abord la fonction Ajouter/Enlever des logiciels 
accessibles depuis le menu Applications (sous Gnome). Vous 
pouvez aussi installer Synaptic qui sait également gérer les 
paquets .rpm. Mais, dans un cas comme dans l’autre, les 
ressources disponibles en logiciels sont quelque peu limitées. 
Impossible par exemple d’installer un lecteur multimédia tel 
que VLC ou Mplayer pourtant très efficaces pour la lecture 
de fichiers vidéo de type DivX ou autres. 

Il existe plusieurs options pour étendre les ressources de Fe-
dora.

La plus simple consiste à « abonner » votre compte Fedora à 
de nouveaux sites ressources. L’un d’eux est un incontourna-
ble : rpm.livna.org qui va vous permettre,  en particulier, d’ins-
taller VLC, Mplayer, KPlayer, GXine, etc. Ces outils multimédia 
peuvent lire des DVD ou des fichiers vidéo DivX...

Pour réaliser cette opération, entrez la commande suivante 
au terminal :

rpm -ivh http://rpm.livna.org/livna-release-6.rpm

(le 6, peut être 5 ou 4 selon la version de Fedora dont vous 
disposez. Pour le savoir, ouvrez avec le navigateur internet la 
page : file:///usr/share/doc/HTML/index.html)

Cette commande consiste à dire à Fedora d’aller aussi re-
chercher sur les serveurs du site rpm.livna.org à l’heure d’ins-
taller un logiciel donné.
Il faut aussi installer un outil de gestion de paquets .rpm autre-
ment plus souple que Synaptic. Yum (Yellow dog updater 
modified) est un candidat parfait. Il fonctionne en lignes de 
commandes depuis le Terminal. Des interfaces graphiques 
sont disponibles : Yumex ou Kyum. Nous expliquons plus bas 
comment les installer.

Yum est normalement installable depuis le menu Applications 
> Ajouter/Enlever des logiciels. Si Yum n’est pas disponible 
dans la liste, vous pouvez télécharger le paquet .rpm depuis 
le site : http://linux.duke.edu/projects/yum/
(section download à gauche)

S

ƒ  Une fois l’outil Yum installé sous Fedora, Suse, Mandriva…
        l’accès à une base de logiciels plus étendue devient possible.

Gestion et installation de paquets .rpm sous Fedora
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Pour fonctionner, Python doit également être installé. Ce qui est 
le cas dans la plupart des situations.

Une fois le paquet .rpm de Yum téléchargé, installez-le avec la 
méthode habituelle (clic-droit puis sélectionner Installation de 
logiciel dans le menu contextuel). Ouvrez ensuite le Terminal et 
entrez les commandes :

su

(pour vous placer en root, mode super-utilisateur nécessitant le 
mot de passe administrateur)

yum update

Cette commande va mettre à jour la liste des logiciels suscepti-
bles d’être installés par Yum.

yum install yumex

Cette commande va installer l’interface graphique Yumex qui 
vous permettra de profiter des fonctions de Yum depuis une in-
terface graphique au lieu de devoir passer par les comman-
des de Terminal. Lorsque Yumex est installé, soit vous démarrez 
l’interface graphique depuis le menu Applications > Outils de 
système > Yum Extender
soit vous continuez d’utiliser la commande yum depuis le Ter-
minal.

Voici quelques fonctions essentielles de yum :

yum list

donne la liste des paquets installés

yum search xmms

cherche si le logiciel Xmms est disponible et peut être installé.

yum info xmms

donne des informations détaillées sur le logiciel indiqué, en l’oc-
currence Xmms.

Le site de Yum :

http://linux.duke.edu/projects/yum/

ƒ  Pour connaître quelle version de Fedora est installée dans votre machine, 
        ouvrez la page /usr/share/doc/HTML/index.html

ƒ  L’interface Yumex de Yum facilite la tâche d’installation de paquets .rps 
        sous Fedora, Open-Suse, Mandriva, etc.

Gestion et installation de paquets .rpm sous Fedora
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orsque vous ouvrez une nouvelle fenêtre sous Gnome, elle peut dis-
poser de sa colonne latérale de navigation dans l’arborescence du 
disque dur, ou ne pas l’afficher. Cette colonne est pourtant intéres-
sante dans la mesure où vous pouvez l’utiliser pour y glisser les icônes 

des éléments que vous souhaitez utiliser le plus souvent. 
Pour que cette colonne latérale soit toujours présente, ouvrez une fenêtre, 
déroulez le menu Edition > Préférences et ouvrez l’onglet Comportement. 
Là, tout vous paraîtra soudain limpide. Il suffira de cocher la case : Toujours 
ouvrir dans des fenêtres de navigation.

L
ƒ  Une fois le réglage enregistré, la colonne apparaît systématiquement.

ƒ  Cochez la case d’ouverture permanente
        de la colonne latérale.

L se peut qu’à la suite d’un plantage quelconque vous ne 
puissiez plus relancer un programme nécessitant les droits 
d’administrateur, et ce, même après avoir fermé la session 
et rouvert votre compte. Pour tenter de remédier à ce pro-

blème fâcheux, rendez vous dans le Système de fichiers pour 
afficher le contenu du répertoire « tmp ». Effacez les fichiers tmp 
marqués d’un sens interdit. Pour y parvenir, ouvrez le terminal, 
saisissez la commande :

su

puis

rm -R 

et surtout, veiller à glisser à la suite AVANT de valider, les fichiers 
à effacer.Validez une fois les fichiers placés à la suite de la com-
mande :

rm -R <glisser ici le ou les fichiers à effacer>

Lancement de programme bloqué

I

ƒ  Par défaut, la colonne latérale n’apparaît pas.

ƒ  Pour remédier à ce problème, il faut aller faire le ménage
        dans le répertoire « tmp » (temporaire).
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Installer Gnumeric
grâce à Macports

i vous avez franchi le pas d’installer 
des logiciels open-source grâce à 
Macports (cf Opensource-Maga-

zine n°8) ou Fink, vous n’êtes pas forcé-
ment à l’abri de petits soucis qui peuvent 
vous conduire à mettre les mains dans le 
cambouis. C’est au passage une excel-
lente occasion de découvrir les arcanes 
de votre système et de mieux en com-
prendre le fonctionnement.

L’exemple de Gnumeric

Pour installer Gnumeric, l’outil de gestion 
de feuilles de calculs (tableur) aussi effi-
cace que souple à mettre en œuvre, la 
commande sous Macports est simple :

sudo•port•install•gnumeric

En toute logique, cette installation de 
la version 1.7.6 ne devrait pas poser de 
problème. Eh bien, il peut arriver que des 
soucis surviennent comme nous avons pu 
le constater. L’installation sous Macports 
a subitement cessé en raison d’un pro-
blème avec l’installation de Python 2.4 
nécessaire à cette version de Gnumeric.
Le message en anglais indique notam-
ment que Python2.4 n’a pas été trouvé 
dans le dossier /opt/local/bin (c’est-à-
dire dans le répertoire de Macports).

De fait, l’installation directe de Python 
par la commande :

sudo•port•install•python24

(remplacez chaque gros point par une 
espace)

échoue au même endroit. 
Peut-on alors tenter d’installer Python « à 
la main » ? 
Qui ne tente rien n’a rien et cette voie 
est évidemment à explorer.

Il faut d’abord retrouver les sources de 
Python sur internet. Dans un moteur de 
recherche, saisissez :

python+official (pour tenter de cibler la 
recherche sur le site officiel de Python).

Une fois sur le site www.python.org re-
cherchez la version 2.4 de Python qui est 
requise pour la compilation de Gnume-
ric. Cliquez à gauche sur le lien Down-
load pour afficher la page contenant 

toutes les versions disponibles. Vous y 
trouverez sans peine une référence à la 
version 2.4.4. Dans la page de cette ver-
sion vous trouverez divers variantes pour 
l’installation sous Windows ou Mac.
Dans notre situation, nous devons installer 
Python dans le répertoire de Macports (/
opt/local), nous allons donc charger les 
sources de Python, disponibles à la sec-
tion « Other platforms » (cliquez sur le lien 
python-2.4.4.tgz). 
A l’arrivée de l’archive, décompressez-la 
pour obtenir un dossier Python-2.4.

A présent, ouvrez une fenêtre de Termi-
nal, entrez la commande cd, faites une 
espace et glissez le dossier Python-2.4 
avant de valider. Ensuite, entrez les com-
mandes :

./configure•--prefix=/opt/local

Vous indiquez en somme que vous sou-
haitez configurer les sources pour que 
Python s’installe dans le répertoire /opt/
local de Macports.

Une fois que cette configuration est ter-
minée, saisissez les commandes :

sudo•make

puis

sudo•make•install

Si vous avez correctement travaillé, la 
version attendue par Macports de Py-
thon devrait trouver son chemin.
Vous pourrez alors reprendre l’installation 
classique par la commande :

sudo•port•install•gnumeric

Notez que nous n’avons pas réussi à ins-
taller la version 1.7.6 de Gnumeric par 
Macports. mais elle a pu être installée 
en suivant tout bonnement cette même 
procédure décrite ci-dessus, à partir des 
sources et en veillant à indiquer lors de la 
configuration :

./configure•--prefix=/opt/local

www.python.org/download/
releases/2.4.4/

http://ftp.gnome.org/pub/GNOME/
sources/gnumeric/1.7/

ƒ  L‘ instal lat ion de Gnumeric via MacPorts n’est pas d’une grande simplici té
      puisqu’ i l  faut en passer par les commandes de terminal

S

ƒ

Gnumeric,
une fois installé,
est un tableur 
extrêmement 
performant
et agréable à utiliser.
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Installer les utilitaires 
de KDE

omment installer sous Gnome Ksnapshot, ou Kview, ou 
tout autre utilitaire graphique issu de l’environnement 
KDE tels que :

kdvi (affiche les fichiers TeX .dvi)
kghostview (affiche les fichiers postscript)
kcoloredit (palette d’édition et de sélection des couleurs)
kiconedit (éditeur d’icônes)
kolourpaint (programme baisque de dessin)
ksnapshot (utilitaire de capture d’écran)
kview (afficheur d’images GIF, JPEG, TIFF, etc.)
kooka (gestionnaire de scanner)
kruler (outil de réglage des couleurs à l’écran)
kpdf (affiche les fichiers pdf)

Il faut installer (avec Yum ou Synaptic) la suite : kdegraphics.

ƒ Ksnapshot est un outil issu de l’environnement KDE pour prendre
       des clichés de l’écran. Il fonctionne aussi sous Gnome sans problème.

C

Rendre un script exécutable

orsque vous souhaitez lancer un script .sh vous pouvez dou-
ble-cliquer sur son icône ou bien le glisser dans une fenêtre 
de terminal et valider la sélection. Un double-clic affiche une 

boite de dialogue proposant de lancer le script depuis une fenêtre 
de Terminal ou sans (bouton Lancer) ou bien encore d’afficher le 
code du programme ou d’annuler. 

Si lors de l’exécution dans un fenêtre de terminal le message 
d’erreur :

« Permission non accordée »

s’affiche, c’est sans doute que le script n’est pas exécutable.

Pour y remédier, ouvrez une fenêtre de terminal et saisissez :

chmod +x

et, après une espace, glissez le script .sh que vous souhaitez ren-
dre exécutable et donc réactif au double-clic.

ƒA l’ouverture du script, vous avez quatre possibilités.

L

• Suse : Une fois le paquet RPM téléchargé, utilisez l’outil « Ins-
tallation de logiciel » fourni avec cette distribution. Faites un 
clic-droit sur l’icône du paquet et allez sélectionner l’utilitaire 
Installation de logiciels qui se chargera du reste,.

• Fedora : Sous Gnome, Ferora fonctionne comme Ubuntu. 
Déroulez le menu Applications > Outils de système pour ac-
céder à l’utilitaire de Mise à jour des logiciels. Pour installer de 
nouveaux logiciels, vous pouvez vous servir de l’outil disponi-
ble dans le menu Applications : Ajouter/Enlever des logiciels. 
Vous pouvez rechercher un logiciel ou bien explorer les rubri-
ques. 

• Ubuntu (et autres dérivés de Debian) : Contrairement à Suse 
ou Fedora, Ubuntu n’utilise normalement que des paquets de 
type Debian (.deb). Mais il est parfois possible d’installer des 
.rpm. Utilisez le logiciel Alien (que vous pouvez installer depuis 
Synaptic, Adept ou Kynaptic). Il faut toutefois que le fichier 
RPM soit compatible avec l’architecture matérielle (i386 ou 
PPC) d’origine.

Installer une archive 
de type  « rpm »

Comment déplacer et effacer dans la foulée un élément ?  

Tout en déplaçant cet élément avec le pointeur de la 
souris vers son nouvel emplacement, maintenez la touche 
Majuscule (Shift) enfoncée. Le fichier sera déplacé/copié 
et effacé à son emplcement d’origine.
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Réussir à lire un DVD
sous Linux

omment lire un DVD sous Linux ? 
La question est évidemment ridi-
cule tant il semble incongru de 
ne pouvoir lire un DVD du com-

merce, légalement acquis, sous un en-
vironnement autre que Mac OS X ou 
Windows (qui embarquent tout l’attirail 
nécessaire). 

Une solution consiste à transférer tout 
le contenu du DVD vers un disque dur 
(puis éventuellement un CD ou un DVD 
comme nous l’avons détaillé dans 
Opensource-Magazine n°2 pp. 18 à 20) 
avec des utilitaires comme Vobcopy 
ou Acidrip.

Il faut généralement ajouter libdvdread 
(s’installe par Synaptic ou Adept) pour 
pouvoir exploiter le contenu d’un DVD. 
Cette méthode est loin d’être souple.

L’autre solution consiste à trouver la 
bonne configuration pour que les DVD 
puissent être lus directement depuis le 
lecteur interne au système Linux, sans 
avoir à transférer leur contenu vers le 
disque dur. 

Les logiciels multimédia tels que Totem, 
GXine, Ogle, VLC, MPlayer, Kaffeine... 
sont censés pouvoir lire des DVD du 
commerce. C’est loin d’être une scien-
ce exacte, notamment depuis que les 
députés français ont accouché dans la 
douleur de la sinistre loi Dadvsi. Dans la 
pratique, cette loi interdit d’utiliser des 
outils pour décoder les DVD ceci afin 
d’en empêcher la copie. Le problème 
est que cette interdiction réduit aussi à 
néant les possibilités de lecture.
Au risque d’être hors-la-loi, si nous es-
timons que la copie est effectivement 
nuisible si elle n’est pas faite dans un 

seul but de sauvegarde, nous considé-
rons inadmissible de ne pouvoir lire des 
DVD sous Linux à cause, précisément, 
de cette restriction.

Voici donc comment procéder pour 
lire un DVD.

• Si vous avez installé Debian, Ubuntu, 
etc, sur Mac (Intel ou PowerPC) ou sur 
PC :

Rendez-vous sur le site :

www.dtek.chalmers.se/groups/dvd/deb

et téléchargez une version récente de 
la librairie « libdvdcss2 » correspondant 
à votre configuration matérielle, par 
exemple :

libdvdcss2_1.2.5-1_powerpc.deb (pour 
un Mac tournant avec un PowerPC)

libdvdcss2_1.2.5-1_i386.deb (pour un 
Mac Intel ou un PC)

Une fois téléchargé, entrez la com-
mande :

sudo dpkg -i 

au terminal et ajoutez à la suite (faites 
une espace après le i) le paquet télé-
chargé. Validez, entrez votre mot de 
passe d’administrateur du poste et va-
lidez à nouveau.

Vous pouvez aussi faire un clic-droit sur 
l’icône du paquet téléchargé et sélec-
tionner l’option « ouvrir avec l’installa-
teur de paquets GDebi » si vous avec 
l’habitude de l’utiliser (cf Opensource-

Magazine n°5 p.14). C’est encore plus 
pratique (image 3). 

• Si sous avez installé Fedora, etc

Rendez-vous sur le site :

http://download.videolan.org/pub/
videolan/libdvdcss/

sélectionnez la version la plus récente 
(1.2.9 par exemple) puis cliquez sur le 
répertoire Rpm afin d’avoir accès aux 
versions de la librairie pour ces distribu-
tions.

libdvdcss2-1.2.9-1.i386.rpm

Il ne restera plus qu’à double-cliquer 
sur le fichier rpm téléchargé pour en 
provoquer l’installation.

Dans tous les cas, vous pourrez aussi té-
lécharger les sources de cette librairie 
et recompiler le paquet si nécessaire.

Une fois que libdvdcss aura été installé, 
VLC, GXine, Kaffeine, Ogle, etc seront 
en mesure de lire les DVD du commer-
ce quels qu’ils soient. Totem et MPlayer 
ne le pourront peut être pas, c’est en 
tout cas le constat que nous avons fait 
sur notre configuration PowerPC (ceci 
expliquant sans doute cela).

ƒ  L’insertion d’un DVD du commerce délivre
        ce message.

ƒ  Voici une variante aux nombreux
        messages d’erreur.

Libdvdcss peut être installé
pour pouvoir lire les DVD
que vous avez achetés.

C image 1

image 2

image 3
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L existe une solution aussi efficace et 
complète que simple pour extraire 
une vidéo d’un DVD : Handbrake (ex 
Mediafork). MediaFork et Handbrake 

ont fusionné pour aboutir à un utilitaire 
parfaitement étonnant par sa facilité 
d’usage. 

• Sous Linux :

Vous pouvez télécharger HandbrakeCLI 
prêt à l’emploi. Les librairies libdvdcss et 
libdvdread doivent être présentes pour 
la prise en charge des DVD (vous pouvez 
les installer avec Yum ou Synaptic selon 
votre distribution).

Handbrake fonctionne à partir du Ter-
minal en ligne de commandes. Plusieurs 
formats de sortie sont disponibles : ogm, 
mp4 et avi. Il suffit de glisser l’élément 
HandBrakeCLI dans une fenêtre de ter-
minal et de compléter la commande 
comme détaillé en haut à droite.

L’option -i sert à préciser le chemin vers le 
dossier VIDEO_TS du DVD à ripper. 
L’option -o indique l’emplacement et le 

nom du fichier résultant du rippage.
L’option -c indique un chapitre à extraire 
(sinon, ce sera tout le disque).
L’option -a permet de sélectionner le 
numéro de la piste audio à conserver (la 
2 correspond souvent au français sur un 
film anglo-saxon). Glissez HandBrakeCLI 
dans une fenêtre de Terminal. La com-
mande sera :
<chemin du fichier HandBrakeCLI> -i 
<glissez ici le dossier VIDEO_TS du DVD> 
-o fichierdesortie.ogm -f ogm 

exemple :

/home/opensource/Desktop/HandBra-
keCLI -i /media/MonFilmDeVacances_TS 
-o FilmFinal.avi -a 2 -c 5 -f avi 

Saisissez l’option -h pour connaître toutes 
les commandes disponibles.

• Sous Mac OS X :

Le logiciel est disponible comme une 
application autonome téléchargeable 
sans autre contrainte technique. Une fois 
installé, lancez Handbrake.
Insérez un DVD. Lancez MediaFork qui 
prend aussitôt en compte le DVD en 
question.
Si nécessaire, cliquez sur le bouton Brow-
se (1) situé en haut à gauche. 

Vous aurez la preuve de la prise en comp-
te du DVD lorsque vous verrez son nom 
s’afficher dans le premier champ. Notez 

I

 

ƒMise en garde : depuis l’avènement de la loi DADVSI anti-copie,
       il est interdit de copier un DVD du commerce. L’opération n’est possible 
       légalement que sur un DVD personnel.

KPlayer ou MPlayer (à droite) sont compatibles de lire les fichiers DivX
produits par Handbrake.

ƒ

Comment extraire une vidéo complète d’un DVD ?
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que vous pouvez aussi sélectionner non 
pas un DVD mais l’image virtuelle d’un 
DVD. 
Le bouton Parcourir (2) sert à désigner 
l’emplacement où vous souhaitez enre-
gistrer le film converti. 
Vous avez loisir de changer le format 
et de désigner un autre codec (3) pour 
changer le processus d’encodage mais 
les valeurs par défaut sont déjà tout à 
fait satisfaisantes. 
La section Audio > Language, vous vous 
en doutez, vous permettra de choisir la 
langue dans laquelle vous souhaitez en-
coder le film.

En appuyant sur RIP, vous lancez le pro-
cessus d’encodage. Le film obtenu sera 
au format .mp4.

http://handbrake.m0k.org

Les sources sont téléchargeables ici :

http://download.m0k.org/handbrake/

• Sur Linux 

(processeur i386 uniquement, processeur PPC non supporté, 
semble-t-il)

Installer au préalable Jam et Nasm (avec Synaptic ou Adept 
selon que vous êtes sous Gnome ou KDE avec Ubuntu). Selon 
les DVD que vous souhaiterez exploiter, la librairie libdvdcss sera 
sans doute requise. Au terminal, entrez la commande : cd

et glissez à la suite, après une espace, le dossier décompressé 
Handbrake, et entrez la commande :

./configure

puis

make

Vous pouvez aussi compiler depuis les sources :

./configure

puis 

jam 

Dans tous les cas, une application HandBrakeCLI sera créée 
dans le dossier initial. Il ne restera plus qu’à lancer cette appli-
cation depuis le terminal pour profiter des bienfaits d’Handbra-
ke en matière de gestion de DVD. Seul gros écueil par rapport 
à la version Mac OS X, il n’y a pas d’interface graphique et tout 
se fait par ligne de commandes !

Pour ripper un DVD, voici un exemple de commande :

HandBrakeCLI•-i•<glissez ici le dossier VIDEO_TS du DVD>•
-o•fichiersortie.avi•-f•avi

le format vidéo peut être : ogm, avi ou mp4

Note : pour les utilisateurs qui travaillent sous une autre distribu-
tion Linux, Jam peut être téléchargé en paquet rpm depuis le 
site : 

http://rpmfind.net/linux/RPM/sourceforge/s/su/suserpm/
jam-2.5-0.i586.html

http://rpmfind.net/linux/RPM/sourceforge/s/su/suserpm/
JByName.html

ftp://fr2.rpmfind.net/linux/sourceforge/s/su/suserpm/
jam-2.5-0.i586.rpm 

Il faut que les outils gcc soient installés pour permettre la com-
pilation de la source rpm.
Si vous ne réussissez pas à installer la version la plus récente, 
tentez votre chance avec une version antérieure.

Sous MacOS X, Handbrake 
lance une interface 

graphique qui facilite 
amplement le travail

sans avoir à passer
par le Terminal.

Installation de Handbrake (ex Mediafork) depuis les sources :

ƒ

Comment extraire une vidéo complète d’un DVD ?
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Certains DVD nécessiteront la librairie libdvdcss2 et livd-
vdread :

http://download.videolan.org/pub/libdvdcss/

Le lecteur de DVD Ogle parait le plus universel pour lire un 
DVD

• Mac OS X 

Bien que l’utilitaire Jam requis pour cette opération soit dispo-
nible avec XCode, il ne faut pas utiliser cette version mais celle 
proposée par le site de HandBrake. Cette autre version se té-
lécharge ici :

http://download.m0k.org/handbrake/
(sélectionner : jam-2.5rc3-OSX.zip) 

Une fois l’archive récupérée, décompressez-la pour obtenir un 
exécutable (icône noire).
Au Terminal, entrez la commande :

cd et glissez à la suite, après une espace, le dossier décom-
pressé Handbrake, et entrez la commande :

./configure

puis

make

Cette méthode va exploiter des paquets précompilés disponi-
bles sur le site de l’auteur. Elle permettra de créer l’application 
Handbrake directement dans le dossier téléchargé.

L’autre méthode consiste à exploiter les sources depuis le Ter-
minal :

entrez la commande :

cd et glissez à la suite, après une espace, le dossier décom-
pressé Handbrake, et entrez la commande :

./configure

puis

glissez l’exécutable jam téléchargé dans la fenêtre du terminal 
et validez pour l’exécuter à son tour.

Note : les outils développeurs XCode doivent être installés.

andbrake est ce que l’on nomme communément un 
«ripper» de DVD, c’est à dire une application qui per-
met d’extraire les pistes audio, vidéo et éventuelle-
ment les sous-titres d’un DVD-Vidéo. L’application qui 

fonctionne de façon austère en mode ligne de commande 
sur toutes les platesformes bénéficie, pour plus de convivialité, 
d’une interface graphique pour Windows et MAC. Pour récu-
pérer le contenu d’un media, l’utilisateur peut au choix insé-
rer son DVD ou réaliser la même opération à partir d’un fichier 
image ISO qu’il aura généré avec une autre application telle 
que DVD Decrypter par exemple. On peut choisir d’extraire 
l’entièreté du DVD-Vidéo ou uniquement certains chapitres. Le 
point fort de cette application est qu’il s’agit d’un deux en un, 
c’est-à-dire d’un ripper couplé à un convertisseur. Les fichiers 
containers convertis seront au choix un AVI, un OGM ou un 
MP4. Les encodages vidéo, quant à eux, sont relativement va-

riés et adaptés aux goûts de chacun (XviD, H0.264, H.264 pour 
iPod…). Concernant la piste audio on retrouve les encodeurs 
traditionnels que sont le MP3, l’AAC, le Vorbis ou l’excellent 
AC3. Dans un souci d’optimisation avancé, il est possible de 
jouer sur le ratio d’image largeur/hauteur selon le support final 
(PSP portable, iPod, écran 4/3 ou 16/9e…), de rogner une par-
tie de l’écran (Cropping) et bien entendu de choisir le nom-
bre de passes pour une qualité d’image plus ou moins fine. On 
peut également, régler les paramètres d’échantillonnage et 
de fréquence audio (plus ou moins compressés), choisir la piste 
audio dans le cas de DVD multilingue et même opter pour dif-
férents mixages sonores (Stéréo, Dolby, Dolby Pro Logic II). En-
fin, pour clore le tour d’horizon, précisons qu’Handbrake gère 
le « queuing » séquentiel, c’est-à-dire les files d’attente des dif-
férentes opérations à réaliser.

Extraire le contenu d’un DVD-Vidéo
est devenu chose courante mais
Handbrake va plus loin puisqu’il permet
la conversion audio/vidéo à la volée 
dans les formats les plus populaires.

H
Par Jean-Christophe Bonalair
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1 Pour fonctionner sous environnement 
Windows, il est nécessaire d’installer 
au préalable les bibliothèques NET.Fra-
mework 2.0 au minimum. Dès le lance-
ment, l’application vous invite à indiquer 
l’emplacement de votre DVD-Vidéo ou 
de votre fichier image ISP. Indiquer la 
lettre du lecteur DVD (E dans notre cas) 
ne suffira pas. C’est pour cela qu’il faut 
spécifier le dossier « :E\VIDEO_TS » qui 
contient généralement à la fois pistes vi-
déo et audio.

2 Dans la fenêtre principale, sous « DVD 
Title » vous pouvez laisser la détection 
sur « Automatique » ou indiquer la piste 
principale (ici la piste 1) dont la durée 
représente 01:28:27 (heure, minutes, se-
condes). Dans le même temps si vous 
comptez extraire les chapitres au cas par 
cas sous « DVD Chapters » entrez les cha-
pitres en les séparant par une virgule.

3 Il faut maintenant dans le cadre 
« Destination », préciser un emplace-
ment de sortie en nommant le fichier qui 
sera créé. Ici, vous pourrez déjà choisir 

le container en MP4, AVI ou OGM. Sous 
la rubrique « Encoder », choisissez, l’en-
codage vidéo, nous optons pour le XviD 
passe-partout et audio qui sera pour 
nous le MP3.

4 Dans le bas de la fenêtre, à l’ongle 
« Picture Settings » (réglages de l’image), 
nous choisissons le découpage automa-
tique des bordures d’écran (Auto Crop) 
et les sous-titres (Subtitles) en français.

5 Concernant l’onglet Video Settings 

nous procédons à deux réglages. L’en-
codage en deux passes pour une image 
ultra-nette mais une durée de conversion 
plus longue et 25 images par secondes 
« dans Video Framerate ».

6 Comme la qualité sonore est impor-
tante à nos yeux, nous nous rendons 
sous l’onglet « Audio Settings ». Ici, nous 
réglons l’échantillonnage (Bitrate) à 
256 kbps et la fréquence (Sample Rate) 
en qualité CD-Audio à 44,1 kHz. Sous 
« Audio Track » nous sélectionnons la pis-
te audio en français. Enfin, dans « Audio 
Mixdown » nous optons pour une conver-
sion en Dolby Surround.

7 L’avant-dernière étape est de se 
rendre dans les paramètres avancés 
(Advanced Settings) et sous « Processor 
Detection » de préciser le nombre de 
processeurs de notre configuration. Les 
possesseurs d’Intel DualCore choisiront 
la valeur 2, les possesseurs plus rares de 
Quad-Core la valeur 4. 

8 Au final cliquez sur le bouton « Enco-
de Video », une console MS-DOS s’ouvre 
sous Windows. Il faut maintenant patien-
ter selon la puissance de votre CPU !

Pas à pas
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orsque vous installez de nouvelles applications, il peut arriver qu’elles ne se répertorient 
dans aucune des rubriques du menu des applications. C’est le cas, par exemple, de 
Kmail, le logiciel de messagerie intégré à Koffice pour l’environnement KDE.

KMail peut fonctionner en application autonome et Synaptic est en mesure de l’installer, 
même sous Gnome.
Seulement une fois installé, il n’est possible de lancer KMail 
que par le terminal ou bien par le menu «Applications/
Lancer une application» où l’on demande le nom de l’ap-
plication (en minuscules). Autant dire que ce n’est pas très 
pratique.

Pour créer un lanceur qui fonctionnera en cliquant sur 
une icône depuis la barre des menus, faites un «clic-droit» 
sur une barre de menus. Dans le menu contextuel, sélec-
tionnez le terme : «Ajouter au panneau» (Add to panel).
Dans la fenêtre ouverte, sélectionnez la première ligne : 
«Lanceur d’application personnalisé» (Custom Applica-
tion Launcher). 
Dans la fenêtre qui suit, donnez un nom à votre raccourci 
et surtout, spécifiez bien la commande qui permet de lan-
cer l’application (kmail dans l’exemple). 

Vous pouvez attribuer une icône à ce raccourci en cli-
quant simplement sur le bouton «icône» et en choisissant 
une image dans la liste.
Validez le tout. Votre raccourci est prêt et fonctionnel.

ƒAjouter au panneau (Add to Panel…)

ƒ Lanceur d’application personnalisé (Custom Application Launcher).

ƒDonnez un nom à votre raccourci et affectez-lui une nouvelle icône.

ƒ Raccourci  opérationnel. ƒ Le choix des icônes se fait parmi toutes les icônes présentes
         dans le système.

L

Astuces

Raccourcis
Créer de nouveaux raccourcis de Tableau de bord.
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ans la famille des systèmes d’ex-
ploitation libre, on a trop ten-
dance à penser que seul Linux 
est une alternative à Windows ou 

Mac OSX.

Pourtant, il existe un système d’exploi-
tation simple à installer et à utiliser.
Pcbsd est, à notre avis, le chaînon man-
quant des systèmes d’exploitation.

Son interface, grâce à Kde est ludique, 
mais ça, ce n’est pas une originalité.
Beaucoup d’autres utilisent KDE.

Les atouts de Pcbsd sont différents :

Aucune connaissance en informati-
que n’est requise, il suffit de lire les ins-
tructions très bien détaillées et illustrées 
sur son écran.
Il n’y a pas de jargon informaticien in-
tempestif, si vous ne comprenez pas, 
passez à l’étape suivante, les choix 
sont pré - établi.

Le système d’installation d’autres pro-
grammes se fait en allant sur leur site. 

Vous choisis-
sez (jeux, sky-
pe, gimpshop 
etc...) ; vous 
téléchargez 
et vous cli-
quez, comme 
avec Mac 
OSX et Win-
dows !
Pas de sudo 
truc much...
Ils nomment 
ça des pbi.

Pcbsd est, en 
partie, basé 
sur son cousin 
Freebsd (Mac 
OSX est aussi de la famille, pour en sa-
voir plus il y a un article sur Wikipédia) , 
la stabilité et la réputation de Freebsd 
ne sont plus à démontrer, de nombreux 
serveurs utilisent Freebsd.

Alors où sont les défauts ?

La reconnaissance du matériel est 
moins complète que Linux et les pro-
grammes moins nombreux.
Mais finalement que faisons-nous avec 
notre ordinateur ?

Si naviguer sur internet (le plug-in flash 
est compatible), écrire des textes, en-

voyer des courriels, et faire un peu 
de retouche vous suffisent, si vous 
n’avez pas le top du top en ordi-
nateur, et que vous voulez lui don-
ner un coup de jeune, Pcbsd est 
conçu pour vous.

Vous pouvez tester facilement 
Pcbsd avec VMware-Fusion sur 
Mac comme sur Pc.

Le site Pcbsd :

http://www.pcbsd.org/

Les programmes pour pcbsd :

http://www.pbidir.com/

		
		
		  Jérôme Geoffroy

D

Pcbsd est une solution facile à mettre en œuvre pour explorer le monde libre

Pcbsd, un autre chemin
vers la liberté

Astuces
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